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يتميز برنامج الفوتوامباكت الذي تقوم بأصداره 
برامج  من  اخرى  حزم  ضمن   -   ULEAD شركة 
على  بقدرته   - الرسوميات  و  الصورة  و  الصوت 
استيعاب و تمثيل متطلبات المبتدئين و المحترفين 
هذا  ان  ذلك   . سواء  حد  على  البرنامج  هذا  في 
قويا  منافسا  الكثيرون  يعتبره  الذي  البرنامج 
لبرامج مثل الكوريل و الفوتوشوب ، قد استطاع 
ان يحتل مكانته الاثيرة لدى المشتغلين في مجال 
معالجة الصور و الرسوميات ، و بصورة تتفوق في 

كثير من الاحيان على برنامج الفوتوشوب.
في  يرغبون  الجرافيكس  هواة  من  الكثيرين  ان 
كيفية  يجهلون  للاسف  لكنهم  و  الاحتراف 
، فأن  ، و من ناحية اخرى  التعامل مع البرنامج 
سوى  توفر  لا  الاجنبية  او  العربية  المنتديات 
سياق  تخدم  لا  لحركات  بسيطة  شروحات 
 » هو  الكتاب  هذا  .عنوان  التسلسلي  التعلم 
تعلم و احترف الفوتوامباكت ١٠ « و المستفيد 
 ULEAD شركة  شروحات  من  شروحه  في 
القارئ  يخدم  المعد بشكل  و    PHOTOIMPACT
الاحتراف.و  مرحلة  الى  يوصله  حتى  المبتديء 
هذا  من   ١٠ النسخة  لماذ   ، البعض  يتسائل  قد 

البرنامج تحديدا؟؟
تتضمن  البرنامج  هذا  من   ١٠ النسخة  ان 
مواصفات قد تم الاستغناء عنها في النسخ ١١ 
لهذا  السابقة  النسخ  ان  الى  بالاضافة   ،  ١٢ و 
ان  دون  و  التعليمي  المحتوى  بفقر  تتميز  الاصدار 

يكون هناك شروح صورية لهذا البرنامج.
الصحة  من  كبير  نصيب  للقول  و   - يقال  و   
الى  يهدف  تدريبي  او  علمي  منهج  كتابة  ان   -
شرح برنامج معين ، هي مهمة تتطلب الكثير 
التقني  بنوعيه  المعرفي  التراكم  و  الجهد  من 
يكون  ان  ينبغي  شيء  كل  فقبل   . الانساني  و 
المنهج اصيلا و مبتكرا ، و يضاف الى هذا اعداد 
السيناريو او الشرح الجيد الذي يشرح و يفسر و 
يكشف ما استغلق من البرنامج ، بالاضافة الى 
او الاخراج الفني النهائي   اعداد الشكل الملائم 

الذي سيخرج فيه العمل بصيغته النهائية.

و نحن اذ نقوم بهذا الجهد المتواضع الذي نأمل ان 
يسد فراغا في المكتبة العربية ، نرجو ان نحقق 
معادلة اخرى فشل الكثيرون في تحقيقها ، الا و 
هي الامانة في اعداد المنهج و مدى اصالته بعيدا 
عن السرقة الواضحة لجهود الاخرين من مواقع 
الاخيرة  الفترة  في  انتشرت  حيث  الانترنيت، 
البحوث  من  الكثير   ، للاسف  فاضح  بشكل  و 
في  اصحابها  من  سرقتها  تمت  التي  التدريبية 
و    . العلمي  الضمير  و  الخلق  ترضي  لا  عملية 
اعدادها  تم  المنهج  هذا  مواد  ان  نقول  للامانة 
الخاصة    ULEAD شركة  شروح  على  بالاعتماد 

بالبرنامج .
يتعلق  ما  في  الاخيرة  تكون  لن  الطبعة  هذه 
ستتبعها  بل  الفوتوامباكت  برنامج  بشرح 
مع   ، مزيدة  و  اخرى منقحة  االله طبعات  انشاء 
مواقع اكثر و شروح و تراجم اكثر.  و ختاما نرجو 
ان يكون هذا الجهد المقل قد حقق شرحا كافيا 
المكتبة  في  فراغا  ملأ  و  البرنامج  هذا  لمتدربي 

العلمية العربية ....

من  الصالحات  بنعمته  تتم  الذي  الله  الحمد  و 
الاعمال.....

ايمن ازهر عزيز 
الموصل - ٢٠٠٨ 

IRAQINLPORG@yahoo.com

و نحن اذ نقوم بهذا الجهد المتواضع الذي نأمل ان 
يسد فراغا في المكتبة العربية ، نرجو ان نحقق 
معادلة اخرى فشل الكثيرون في تحقيقها ، الا و 
هي الامانة في اعداد المنهج و مدى اصالته بعيدا 
عن السرقة الواضحة لجهود الاخرين من مواقع 
الاخيرة  الفترة  في  انتشرت  حيث  الانترنيت، 
البحوث  من  الكثير   ، للاسف  فاضح  بشكل  و 
في  اصحابها  من  سرقتها  تمت  التي  التدريبية 
و    . العلمي  الضمير  و  الخلق  ترضي  لا  عملية 
اعدادها  تم  المنهج  هذا  مواد  ان  نقول  للامانة 
الخاصة    

يتعلق  ما  في  الاخيرة  تكون  لن  الطبعة  هذه 
ستتبعها  بل  الفوتوامباكت  برنامج  بشرح 
مع   ، مزيدة  و  منقحة  اخرى  االله طبعات  انشاء 
مواقع اكثر و شروح و تراجم اكثر.  و ختاما نرجو 
ان يكون هذا الجهد المقل قد حقق شرحا كافيا 
المكتبة  في  فراغا  ملأ  و  البرنامج  هذا  لمتدربي 

من  الصالحات  بنعمته  تتم  الذي  الله  الحمد  و 
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عالم الألوان 

على  التدريب  في  الشروع  الاحوال  من  حال  بأي  يمكن  لا   
برامج الجرافيكس دون ان يكون لدينا ادنى خبرة او معرفة 
.من  مشاريعنا  في  سنستخدمها  التي  الالوان  بمدلولات 
التصميم  برامج  مستخدموا  يستعين  ان  جدا  الضروري 
بالالوان من اجل اثراء مخيلتهم .ان اللون قديم قدم الانسان 
وله مدلول عام عند الشعوب ومدلول خاص عند الأفراد . 
فالشعوب أتخذت الالوان رمزا عاطفيا أو سياسيا لكيانها 
, مثل ( علم الدولة ) فكل علم يحمل رمزا أو رموزا, وهذا 
فقد   , الرموز  دلالات  تتنوع  وقد   . نفسية  دلالات  له  الرمز 
 . ....الخ  اجتماعية  أو  عرقية  أو  سياسية  أو  دينية  تكون 
فالامويون مثلا كان شعارهم اللون البيض وهذا اللون له 
اللون  شعارهم  كان  والعباسيون   , لديهم  نفسية  دلالة 
الأسود , وكذلك العلويون كان شعارهم اللون الأخضر .... 

وهكذا . 
ترمز لنفسها رموزا تستعمل في ساحات  الدول  ان  كما 
لنفسها  تكون  والقبائل   . والجنود  القادة  وعند  الحرب 
شعارات ملونة تتميز بها عن الغير حين أعلان الحرب على 
غيرها . ويمكن للفرد البدائي أن يزين نفسه بالالوان وذلك 
تقربا للعبادة والصلاة , وكثيرا ما نجد في العبادات الهندية 
الكهنة  يلبسها  التي  الالوان  رموز  على  تعتمد  والبوذية 
مختلف  في  الدين  رجال  بين  نشاهدها  كما   , الآن  حتى 

الديانات .
ان مظهر الألوان له دور عاطفي واضح عند الأطفال يختلف 
عنه عند الشباب , فالطفل يفرح بالالوان الأساسية أيام 
والبهرجة  للزينة  وذلك  والاحمروالاصفر  كالازرق  العيد 
بينما   . الطفل  نفس  في  اعتيادية  غير  حاجة  وتضمين 
 , الحب  رمز  الأحمر  مثل   , أخرى  رموزا  تأخذ  الشباب  عند 
والبنفسجي المزرق رمز الأمل , والأصفر رمز اد والبهجة 
والرخاء ..الخ . أما عند الكهول والشيوخ فالأمر مختلف 
وخير دليل على خفوت العاطفة هو اهتمامهم بالالبسة 
الرمادية   ) الثلاثية  الضوئية  الدرجات  من  ألوانها  المكونة 

البيضاء والسوداء ومشتقاتها ) .
علماء  فأن   , الاساسي  الموضوع  عن  كثيرا  لانبتعد  ولكي 
النفس خير من درس سيكولوجية الألوان وتأثيراتها على 
من  جانبا  يشكل  اللون  ادراك  أن  أكدوا  فقد   , الأنسان 
سلوك الأنسان , وان هذا السلوك يتحدد بثلاثة أبعاد هي : 
البيئة أو العالم الخارجي , والعالم الفسيولوجي الداخلي 
, والعالم السيكولوجي الداخلي , والذي يتضمن متغيرات 
يرتبط  ما  غالبا  اللون  وان   . الأنفعالات  بينها  من  كثيرة 
بالأحساس بالسعادة أو نقيضها . ويفضل معظم الناس 
بعض الالوان أكثر من غيرها , ويبدو ان هذا التفضيل يأخذ 
ـــ  الأزرق   : الآتي  النسق  الاوربيين حسب  ثابتا عند  ترتيبا 

الأحمرـــ الأخضرـــ الارجواني ـــ البرتقالي ثم الأصفر. 
الألوان  تأثيرا من  أقل  المتداخلة فعادة ماتكون  الألوان  أما 
. وهناك بالطبع أختلافات واضحة,   ( النقية   ) الأساسية 
حيث يفضل بعض الناس الألوان البراقة في حين يفضل 
 . الداكنة  الألوان  غيرهم  ويفضل  الهادئة  الألوان  آخرون 
أنفعالية خاصة  تثير أستجابات  ربما  ألوان معينة  وهناك 
, فالأحمر يرتبط بالأثارة أو الغضب , والأزرق يرتبط بالفرح 

الهادئ , والأسود يرتبط بالحزن والأكتئاب . وهكذا .........
أمزجة  أو  معينة  لمشاعر  رمزا  تشكل  ربما  الألوان  أن  كما 
خاصة أو علاقات محدودة في حياة الفرد , وربما تمثل أيضا 
أستجابات أو ردود فعل مختلفة أو متباينة أو مجالات من 
الصراع النفسي . وبسبب وجود الكثير من الغموض في 
ينصحوا  النفس  علماء  فأن   , اللون  استعمال  تفسيرات 
بعدم ترك العنان لتذوقنا الشخصي عند أختيار الألوان . 
فمثلا الألوان التي نراها في بيوتنا هي التي تبين لنا مدى 
من  الكثير  عن  نفسه  الوقت  في  وتنم   , بالألوان  تأثرنا 
ميولنا وطباعنا وعاداتنا في الحياة .فاللون الأخضر  يعتبر 
الى الأسترخاء  يؤدي  , لأنه  النوم  الألوان لغرف  من أنسب 
الذي   ( الزيتوني  الأخضر   ) وبالأخص  والعضلي  الذهني 
خلال  كامل  يوم  متاعب  غسل  قادرعلى  بأنه  يوصف 
دقائق قليلة , كما أنه من الألوان الملائمة لواجهات المحال 
الزبائن  يدخلها  التي  الأماكن  من  يجعلها  أذ   , التجارية 
بطريقة تلقائية . وقد تم أستخدام اللون الأخضر في طلاء 
أحد الجسور في مدينة لندن وهو جسر ( بلارك فراير ) مما 
الجسر  هذا  فوق  الأنتحار  نسبة حوادث  أنخفاض  الى  أدى 
نحو الثلث , حيث أعاد اللون الأخضر شيئا من السرور الى 

النفوس اليائسة .
أما اللون الأحمر  فبالرغم من أنه لون مشرق يبعث على 
البهجة , ألأ انه ينصح بالأبتعاد عنه في غرف النوم , لأنه 
يؤدي الى التنبه العصبي والذي يؤدي بدوره الى حالات الأرق 
الدراسة  لتزيين غرف  , وهويصلح فقط  وعدم الأسترخاء 
والنفسية  العلمية  الدراسات  .وتشير  التسيلة  والعاب 
العقلية  الأضطرابات  شفاء  في  أستخدامه  تم  أنه  الى 
رجال  أحد  أن  المصرية  الصحف  أحدى  في  قرأت  فقد   ,
خسارة  به  نزلت  الأمريكية  المتحدة  الولايات  في  الأعمال 
أعصابه  في  فأثرت  الأفلاس  الى  به  تؤدي  كادت  فادحة 
وأضطربت   قواه العقلية , فأدخل على أثرها مستشفى 
الأمراض العصبية . وفي المستشفى رفض تناول الطعام 
أياما فأدخله الطبيب غرفة جدرانها حمراء وكل ما فيها 
من أثاث يصطبغ باللون الأحمر , وما هي الا أربع وعشرون 
ساعة حتى عادت الى المصاب شهيته فطلب طعاما وراح 
أن  بعد  عهده  سابق  الى  عاد  وهكذا  بشراهه.  يلتهمه 
تخلص مما أصيب به من الذهول والغم اللذين كانا يؤديان 
به الى الجنون .أما اللون الأزرق  فهو من أفتر الالوان وأقلها 
التهيج  حالات  من  للتخفيف  عادة  ويستخدم   , ايجابية 
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والتأثر التي تصيب بعض النفوس , فهو مهدئ ويفضله 
الدم  أنه يخفض من ضغط  . كما  المصاب بداء الأعصاب 
 . الباطني  والتأمل  السلام  الى  ويدعو  التنفس  ويهدئ 
ويفضل أستعماله لتأمين السكينة الا أنه لايمنع أن يكون 
للون الأزرق تأثير سلبي على ذوي الأمزجة السوداوية الذين 
تغلب عليهم الكآبة , فعلى هؤلاء أن يتخلصوا من كل ما 

هو أزرق ويحيطوا أنفسهم بكل ما هو أحمر .
مكان  طلاء  وعند   , الباردة  الألوان  من  يعتبر  الأزرق  واللون 
معين بهذا اللون فأنه يوحي للشخص أن المكان بارد . ففي 
أحدى المؤسسات التجارية طليت جدران قاعة تعرض فيها 
البضائع التجارية باللون الأزرق بعد أن كان أبيض فكثرت 
أحتجاجات الزبائن من أن القاعة المذكورة باردة الى درجة 
يعلم  الذي  الخاص  المؤسسة  مهندس  أدهش  مما  مزعجة 
جيدا أن حرارة القاعة هي اياها لم تتبدل عما كانت عليه 
اللون  وهو  آخر  بلون  نفسها  الجدران  وطليت  شهر,  منذ 
اللون الجديد فعادت  , كما طليت المقاعد بهذا  البرتقالي 
حرارة  من  المرة  هذه  كانت  الشكوى  ولكن  الأحتجاجات 
جو القاعة بالرغم من أن درجة الحرارة الأصلية لم تتبدل 
, ولما غيروا لون المقاعد البرتقالي أعتدل جو الغرفة وزالت 

الشكاوى .
الألوان  ناتج من استخدام بعض  المبيع  ازدياد  أن  والملاحظ   
في  الالوان  سائر  دون  من  السيكولوجي  التأثير  ذات 
الأحمر  أن  المتعددة على  الأحصاءات  دلت  , فقد  الأعلانات 
الألوان  والأخضر هي خير  والبرتقالي  أنواعه  أختلاف  على 
فأنهما  والبنفسجي  الأزرق  اللون  أما   . والدعاية  للأعلان 
. أما  لايصلحان للدعاية والأعلان بأي شكل من الأشكال 
اللون الأصفر  فهو لون أرضي وعملي وربما من أفرح الألوان 
العصبي  الوهن  أي  النورستينيا  ويستعمل لمعالجة مرض 
لايمكن  انه  الا   , معتمة  غرفة  في  للاستعمال  ويصلح   ,
والتقيؤ  الغثيان  يسبب  لأنه   , الطائرات  في  استعماله 

لذلك تم أستبعاده في الطائرات .
على  ويساعد  ومثير  دافئ  لون  فهو  البرتقالي   اللون  أما 
الشهية ويسهل عملية الهضم , ويعجل بشكل خفيف 
للمطاعم  المناسبة  الألوان  من  ويعتبر   . القلب  نبضات 
العامة والمطابخ وحجرات الطعام , كما أنه يناسب غرف 
الجلوس المعرضة بشكل سئ للشمس , ويصلح أستعماله 
باللون  يمتزج  أن  بعد  الجدران  وعلى  الغرفة  أرضية  على 
وعند   . ملحوظ  بشكل  تفتيحه  يتم  أن  وبعد   , الرمادي 

مدخل البيت يصبح لونه جذابا وباعثا للرضا والسرور.
بعدم  ينصحوا  النفس  علماء  فأن  الأسود   اللون  وأخيرا 
أستخدامه في ديكور المنزل حتى وأن كا ن في نطاق ضيق 

, لأنه لون يبعث على الأنقباض واليأس .
داخل  مختلفة  ودرجات  الوان  استخدام  على  الحرص  ان 
المنازل , يعد من الأمور الهامة التي تريح العين وتجنب الفرد 

من  تزيد  الفاتحة  الألوان  أن  مراعاة  مع   , بالملل  الأحساس 
أحساس الشخص بأتساع المكان , بينما الألوان الغامقة 
توحي بضيق المكان . كذلك يستطيع اللون توليد أحساس 
ذات  صناديق  بأن  لوحظ  فقد   , الخفيف  أو  الثقيل  بالوزن 
للعمال  وزنا  أقل  تبدو  مماثل  وزن  وذات  مقاييس متشابهة 
. على  الفاتح  باللون  ملونة  تكون  يحملونها عندما  الذين 
العموم , فأن الألوان كالعقاقير يجب أن تؤخذ بمقادير معينة 
والا كانت عواقبها وخيمة , وعلى هذا ينبغي لأرباب المنازل 
أن يعرفوا كيف يوزعون الألوان في حجراتهم لئلا يسيئوا 
الى نفوسهم من حيث لايدرون . كما يجب اهتمام كل أم 
بالوان جدران غرفة أطفالها والوان ملابسهم بنفس قدر 
تعتاد  التي  للالوان  لما   , ونظافتهم  بطعامهم  اهتمامها 
عليها عين الصغير من تأثير كبير على ملامح شخصيته 

فيما بعد .
تلعب الألوان دورا مهما في حياتنا وتؤثر في نفوسنا، وبدون 
الألوان تصبح الحياة كئيبة ومملة .. واختيار المرء لألوان معينة 
دلالة على ميوله ورغباته واستعداداته وحالته النفسية. 
نعيش  أو  لنلبسها  نختارها  التي  الألوان  أن  القول  ويمكن 
معها, هي انعكاس لحالة مؤقتة أو طويلة الأمد لكياننا. 
ورد الفعل النفسي لدينا تجاه بعض الألوان يرجع إلى حد 
ألوان  استخدمت  وقد  تحتويها.  التي  الرمزية  للمعاني  ما 
معينة على مر العصور القديمة كرموز لها دلالات معينة 
استخدم  فمثلاً  القراءة.  يجيدون  لا  كانوا  اللذين  لأولئك 
اللون الأبيض ليوحي بالطهارة، الأسود دلالة على الشر أو 
الموت،بينما كان اللون الرمادي يرمز إلى التوبة، وعلى نفس 

المنوال بقية الألوان. 
الأخضر : 

اللون فأنت إنسان عاطفي تحب خدمة  إن كنت تحب هذا 
وتتميز  إنسان  كل  على  وتحنو  الهدوء  وتحب  الآخرين 
تحلها  فانك  مشكلة  واجهتك  وإذا   , لطيفة  بطبيعة 
بهدوء ولا تلجأ إلى العنف والصراخ إلا في أضيق الحدود. 
يتصفون بالإنتاجية والصبر وبالدقة في عملهم, يعرفون 
كيف يحافظون على شبابهم حتى سن متأخرة يسيرون 
ثابتة  ولكنها  بطيئة  بخطى  غاياتهم  تحقيق  تحقيق  إلى 
وكفيلة بأن توصلهم إلى هدفهم المنشود. هم اجتماعيون 
ونشيطون وفخورون بأنفسهم, لديهم أفكار نموذجية عن 
الحياة, أن نوع القلق المصاحب لهذا اللون يعبر عن نفسه 

بارتباكات في المعدة. 
اللون الأصفر: 

عملي  إنسان  يحبه  من  للأذكياء,  المفضل  اللون  هو 
بالمرح  يمتاز  منه,  ينتفع  شيء  كل  ويحب  وموضوعي 
التغيير  وتحب  الجديدة  بالأفكار  كثيرا  تهتم  والانطلاق, 
وراء  سعيا  أخرى  إلى  بيئة  ومن  لأخر  مكان  من  والتنقل 
والأمل,  والفكر  التعقل  لون  بالأساس  وهو  جديدة.  وجوه 

من  تزيد  الفاتحة  الألوان  أن  مراعاة  مع   , بالملل  الأحساس 
أحساس الشخص بأتساع المكان , بينما الألوان الغامقة 
توحي بضيق المكان . كذلك يستطيع اللون توليد أحساس 
ذات  صناديق  بأن  لوحظ  فقد   , الخفيف  أو  الثقيل  بالوزن 
للعمال  وزنا  أقل  تبدو  مماثل  وزن  وذات  مقاييس متشابهة 
. على  الفاتح  باللون  ملونة  تكون  يحملونها عندما  الذين 
العموم , فأن الألوان كالعقاقير يجب أن تؤخذ بمقادير معينة 
والا كانت عواقبها وخيمة , وعلى هذا ينبغي لأرباب المنازل 
أن يعرفوا كيف يوزعون الألوان في حجراتهم لئلا يسيئوا 
الى نفوسهم من حيث لايدرون . كما يجب اهتمام كل أم 
بالوان جدران غرفة أطفالها والوان ملابسهم بنفس قدر 
تعتاد  التي  للالوان  لما   , ونظافتهم  بطعامهم  اهتمامها 
عليها عين الصغير من تأثير كبير على ملامح شخصيته 

تلعب الألوان دورا مهما في حياتنا وتؤثر في نفوسنا، وبدون 
الألوان تصبح الحياة كئيبة ومملة .. واختيار المرء لألوان معينة 
دلالة على ميوله ورغباته واستعداداته وحالته النفسية. 
نعيش  أو  لنلبسها  نختارها  التي  الألوان  أن  القول  ويمكن 
معها, هي انعكاس لحالة مؤقتة أو طويلة الأمد لكياننا. 
ورد الفعل النفسي لدينا تجاه بعض الألوان يرجع إلى حد 
ألوان  استخدمت  وقد  تحتويها.  التي  الرمزية  للمعاني  ما 
معينة على مر العصور القديمة كرموز لها دلالات معينة 
استخدم  فمثلاً  القراءة.  يجيدون  لا  كانوا  اللذين  لأولئك 
اللون الأبيض ليوحي بالطهارة، الأسود دلالة على الشر أو 
الموت،بينما كان اللون الرمادي يرمز إلى التوبة، وعلى نفس 

اللون فأنت إنسان عاطفي تحب خدمة  إن كنت تحب هذا 
وتتميز  إنسان  كل  على  وتحنو  الهدوء  وتحب  الآخرين 
تحلها  فانك  مشكلة  واجهتك  وإذا   , لطيفة  بطبيعة 
بهدوء ولا تلجأ إلى العنف والصراخ إلا في أضيق الحدود. 
يتصفون بالإنتاجية والصبر وبالدقة في عملهم, يعرفون 
كيف يحافظون على شبابهم حتى سن متأخرة يسيرون 
ثابتة  ولكنها  بطيئة  بخطى  غاياتهم  تحقيق  تحقيق  إلى 
وكفيلة بأن توصلهم إلى هدفهم المنشود. هم اجتماعيون 
ونشيطون وفخورون بأنفسهم, لديهم أفكار نموذجية عن 
الحياة, أن نوع القلق المصاحب لهذا اللون يعبر عن نفسه 

عملي  إنسان  يحبه  من  للأذكياء,  المفضل  اللون  هو 
بالمرح  يمتاز  منه,  ينتفع  شيء  كل  ويحب  وموضوعي 
التغيير  وتحب  الجديدة  بالأفكار  كثيرا  تهتم  والانطلاق, 
وراء  سعيا  أخرى  إلى  بيئة  ومن  لأخر  مكان  من  والتنقل 
والأمل,  والفكر  التعقل  لون  بالأساس  وهو  جديدة.  وجوه 
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والذين يحبون اللون الأصفر اللامع هم أشخاص يتمتعون 
بتفكير اصلي ولديهم طاقات مختلفة بمستويات متنوعة, 
من  أكثر  عملية  ومشاريع  مهمات  في  الخوض  ويرغبون 
خوضهم في الكلام غير الناضج. هم شخصيات متفائلة 
تستطيع أن تقيس الإحساس والمشاعر الجيدة والناضجة. 

اللون الأبيض: 
هو لون ذو الفكر الواضح النقي, ودليل على الترف, ومحبوا 
الإعجاب  على  يستحوذوا  أن  في  رغبة  لديهم  اللون  هذا 
والثقة.  للأمانة  والأقرب  النظافة,  على  حريصون  وهم 
والابيض هو اللون الذي يستحسنه اولئك الذين يفتقرون 

إلى قوة الملاحظة والبديهة وروح الانتقاد . 
الكحلي : 

هو لون التدين , يتمع ذوي اللون الكحلي بميل طبيعي إلى 
مساعدة الناس و وبرباطة الجأش والهدوء وقد لا يتكلمون 
كبار  الغالب  في  إنهم   , معهم  بالارتياح  ونشعر  كثيرا 
في  المريح  والإحساس  الهدوء  طبع  على  وقادرون  ولطفاء 

نفوسنا . 
اللون البنفسجي: 

, فاذا كنت تحب هذا  هو لون العظمة والفخامة والتميز 
اللون فانك ذو شخصية صعبة , وان ثقتك بنفسك قوية 
. قد تكون أحيانا صعب الفهم. أصحاب هذا اللون يحبون 

أن يكونوا مختلفين. 
اللون البرتقالي: 

بنفسك  تعتز  المسالمين,  الودودين  الأشخاص  من  أنت 
وبكرامتك, كثرة ارتداء هذا اللون ( الباهت منه ) يدل على 

الحزن والضعف والخوف. 
اللون الأزرق: 

اللون  هذا  تحب  كنت  وان  الحساسة,  النفوس  لون  هو 
أثناء  فانك تأخذ في اغلب الأحيان قرارات غير صائبة في 
انك إنسان مخلص وصريح وصادق,  تفتيشك عما ترغب 
مشاعر  تقدر  الفلسفية.  الأفكار  في  الغوص  إلى  وتميل 
الاخرين وتهتم بهم تميل إلى الصداقات الدائمة والمعمرة, 
اللطيفة  الهادئة  والحياة  الاحباب,  واستضافة  وضيافة 
إلى  الانسحاب  إلى  تميل  فانك  حاجاتك  تلبي  لا  عندما 
داخل ذاتك واتخاذ موقف الدفاع, ومن غير المرجح أن يكون 
صاحبه رائدا مشهورا. إذا أردت أن تكون قائدا أو مجددا أو 
صاحب قوة غير عادية فلا بد من أن تستخدم اللون الأزرق 
برودة  من  درجة  على  يدل  الأزرق  اللون  لان  كبير,  بشكل 
الأعصاب وعدم الحزم والقوة, ويفيد لبسه عندما نتحدث 

في محاضرة أو ندوة. 
الوردي: 

لون المرح والطفولة والعذوبة والأنوثة والوداعة في نفس 
لطفهم  من  الرغم  على  بالثقة  جديرين  غير   . الوقت 

وجاذبيتهم يفتقرون لقوة الارادة . 
اللون الأحمر: 

هو لون الناس الذين يتصفون بالحزم والحيوية الدافقة, قوي 
شجاع وجريء وتحب المغامرة وتحب الآخرين, وتعشق الإثارة, 
توجد  يحبونه,  أيضا  والطائشون  الأحمر  يحبون  الأطفال 
لدى الأشخاص الحمر شهية هائلة للحياة يحيون كل يوم 
جديد بحماس لا يفتر يميلون بشكل أساسي إلى العيش 
( القضية  الزواج قديما يسمى  في ساعتهم الآنية, وكان 
الحمراء) وفي الهند والتبت كان اللون الأحمر يرمز إلى قوة 
الخلق الموجودة في النساء والى طاقة وقوة العاطفة والى 
المشاعر النبيلة والايجابية, والعرب يصفون المرأة الجميلة 

بأنها حمراء اللون . 
اللون البني: 

وقوية,  حازمة  ذو شخصيات  أناس  اللون  بهذا  الشغفون 
الغير,  للتفتيش عن عيوب  أنانيون وميالون  ديون  وهم ما 
من جهة  إحساسهم  أن  بهم, كما  أذواق خاصة  لديهم 
التوفير خاص جدا. صبورون يتحملون المكاره بصدر رحب 
كما  لنفوسهم  يتطرق  اليأس  يدعون  لا  اخفاقهم  وعند 

أنه يحمل علامة الضجر وعدم الانسجام . 
اللون الرمادي: 

يتصفون  الحذر,  الشديدوا  المتحفظون  اللون  هذا  يختار 
في  أنفسهم  يورطوا  ألا  على  حريصون  اللاذع,  بنقدهم 
شيء يأتي لهم بالملامة, والقماش الرمادي الغامق يبطيء 

الناس. 
اللون الأسود:

ويريدون  غامضون  اللون  هذا  ومحبي   , للتقاليد  يرمز 
اللون  هذا  يفضل   . الخاصة  حياتهم  الغير  يحترم  أن 
المتشائمون وهذا اللون ليس لونا حقيقيا لأنه غير موجود 
في ألوان الطيف, والأسود يمتص جميع الألوان ولا يعيد ولا 
يعطي أي لون منها, وتدل التقاليد على أن الأسود هو لون 
الحزن في العالم الغربي وثقافاته, وهو لون تلبسه عندما 
تحتاج ان تتحكم بالوضع والحالة, ولكن لا تتوقع أن تجمع 
الأصدقاء بسهولة أو أن تستحوذ على مشاعر الثقة عند 

الآخرين إذا كنت ترتدي الملابس السوداء.
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البسيطة  والمعارف  المعاني  الضروره معرفة بعض  يبقى من  والجرافيك  التصميم  الجميع في عالم  انطلاق  بدايه  مع 
واليكم بعض هذه المعاني والمعارف :

البيكسل : مأخوذ من الكلمة الأنجليزية Pixel يتكون من المقطعين picture element ويعني عنصر الصورة، البكسل 
هو أصغر عناصر الصورة وهو على شكل نقطة او مستطيل صغير، مجموعة من البكسلات (في سطح ثنائي الأبعاد) 
تشكل الصورة. وعادة ماتكون البكسلات صغيرة وبكثافة كبيرة حتى تُكون صورة أحسن. يحدد الحاسوب شدة إضاء 
كل بكسل ولونه لتكوين الصورة الكلية، بالنسبة للصور الملونة فأن البكسل يقسم إلى أجزاء أصغر تعرف بالسب-

بكسل sub-pixels .هو عبارة عن الوحدة الصورية التي يتكون منها كل ما نراه على شاشة الكومبيوتر فما نراه على 
شاشة الحاسبة هو عبارة عن تجمع لوحدات صغيرة جدا تتموضع بجانب بعضها البعض و كل وحدة منها تسمى 
البكسل و يتم قياس دقة الصورة على الشاشة بعدد البكسلات في الوحدة الطولية و كلما زادت البكسلات ، زادت 
.ان الشاشات مثلا تكون بأحجام هي ٨٠٠×٦٠٠ وهناك شاشات بشكل آخر ١٠٢٤× ٧٨٦ وهذا يعني ان  دقة الصورة 

الشاشه تتكون من ٨٠٠ بيكسل عرض و٦٠٠ بيكسل طول

هذا مثال لصورة ١٦×١٦ بكسل مكبرة ٨ مرات لرؤية البكسلات المكونة للصورة 

البسيطة  والمعارف  المعاني  الضروره معرفة بعض  يبقى من  والجرافيك  التصميم  الجميع في عالم  انطلاق  بدايه  مع 

 ويعني عنصر الصورة، البكسل 
هو أصغر عناصر الصورة وهو على شكل نقطة او مستطيل صغير، مجموعة من البكسلات (في سطح ثنائي الأبعاد) 
تشكل الصورة. وعادة ماتكون البكسلات صغيرة وبكثافة كبيرة حتى تُكون صورة أحسن. يحدد الحاسوب شدة إضاء 

 .هو عبارة عن الوحدة الصورية التي يتكون منها كل ما نراه على شاشة الكومبيوتر فما نراه على 
شاشة الحاسبة هو عبارة عن تجمع لوحدات صغيرة جدا تتموضع بجانب بعضها البعض و كل وحدة منها تسمى 
البكسل و يتم قياس دقة الصورة على الشاشة بعدد البكسلات في الوحدة الطولية و كلما زادت البكسلات ، زادت 
 وهذا يعني ان 
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برنامج الفوتوامباكت .... خيارات مفتوحة ام محددة؟؟

ما هــو البيـــكسل؟؟
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برنامج الفوتوامباكتتع

 من البرامج السهله الاستخدام و يعتبر  من البرامج القوية في تحرير الصور ، وبالذات الصور الفوتوغرافية وتصميم 
صفحات الويب وعمل النقوش والأشكال ثلاثية الأبعاد بطريقة سهلة بسيطة تنفع لكافة أنواع المشاريع.

مميزات البرنامج
التصوير الفوتوغرافي :عن طريق الكاميرا الرقمية بالبرنامج تقنيات محترفة تساعدك على تحسين الصورة وإعطاؤها 

المظهر المحترف للتصوير كما يمدك بإمكانية طباعة الصور بمنتهى الوضوح والسهولة.
تصميم صفحات الويب: يوجد بالبرنامج أدوات ويب متكاملة تساعدك على تصميم صفحتك بمنتهى السهولة بدون 

معرفة محترفة لذلك َتحتوي إضافةَ أزرارَ تفاعليةَ بالإضافة إلى تأثيراتِ جافاسكريبت بدون مجهود كتابة الاكواد .
وفرش  والتبهيت  الحرق  أداة  مثل  السهولة  بمنتهى  رسوماتك  تصميم  من  الرسم  أدوات  الصور:تمكنك  وتحرير  الرسم 

الرسم اتلفة الأشكال ومجموعة من الفلاتر الجاهزة وإمكانية إضافة الفلاتر التي ترغب.
تحريك الصور:البرنامج به بعض الحركات الجاهزة بطريق الفريمات كما يمكنك التعديل في هذه الحركات والأشكال ثلاثية 
الأبعاد يمكنك البرنامج من إمكانية الرسم الثلاثي الأبعاد بمنتهى السهولة وإضافة التأثيرات عليها كما سيلي ذكره.
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يتكون هذا البرنامج كما نرى من :
١ - شريط العنوان.
٢ - شريط القوائم.

٣ - شريط المهام الي يتغير تبعا للمهمة او الاداة التي تقوم بتفعيلها.
٤ - شريط الخيارات.

٥ - لوحة الادوات التي توجد على يسار المستخدم.
٦ - لوحة ادارة النوافذ التي توجد على يمين المستخدم.

٧ - لوحة السيطرة القياسية على الالوان.
٨ - شريط الحالة.

قوائم البرنامج
و فيما يلي شرح للقوائم التي يتألف منها البرنامج:

١ - The File Menu قائمة الملف.           
٢ - The Edit Menu قائمة التحرير . 

٣ - The Adjust Menu قائمة التعديل .   
٤- The Photo Menu قائمة الصورة.

٥ -  The Effect Menu قائمة المؤثرات.
٦ - The Selection Menu قائمة الاختيار. 

٧ - The Object Menu قائمة الكائنات الرسومية.
٨ - The Web Menu قائمة موقع الويب.

٩ - The View Menu قائمة المشاهدة.
١٠ - The Help Menu قائمة المساعدة.   

١٠
ت 

باك
ام

تو
فو

 ال
ف

تر
اح

 و 
لم

تع
صورة لواجهة البرنــــامج



10

١٠
ت 

باك
ام

تو
فو

 ال
ف

تر
اح

 و 
لم

The File Menu قائمة الملف            تع
The File Menu قائمة الملف            

New... القيام بفتح صورة جديدة او موقع ويب جديد.
Open... القيام بتصفح قرصك الصلب بحثا عن 

صورة معينة. 
Browse... القيام بفتح مدير التصفح من اجل 

تمكين المستخدم من رؤية و اختيار الصورة في القرص 
الصلب.

Open from Web.. القيام بفتح صورة ما مباشرة 
من الانترنيت او القيام بفتح موقع الانترنيت كصورة. 

Restore.. القيام بأعادة الصورة الى ما كانت عليه 
سابقا 

Close... القيام بأغلاق الملف
Save... القيام بحفظ الصورة الى الملف الموجود 

Save As... القيام بحفظ الملف كملف جديد
Save All... القيام بحفظ كل الملفات المفتوحة

Save for Web... القيام بصنع مستند هتمل جديد 
و القيام بتهئة صورك من اجل النشر على الويب

Preview in Browser... القيام بأستعراض الملف في 
المستعرض و من الممكن عرض الصور المرفقة 

Batch Convert... القيام بتحويل الصورة / مجموعة
 الصور في كل الملفات الى نوع آخر 

Digital Camera... القيام بفتح مفاعل الكاميرا 
الرقمية

Scanner... القيام بتجميع الصور من جهاز الماسح 
الضوئي

Import... القيام بفاعلية الاستيراد
Export... القيام بفعالية التصدير الى سطح المكتب 

او الايميل او الى مواقع الويب
هي  و  الشاشة  صورة  التقاط   ...Screen Capture
 print screen زر التي يقوم بها «  مشابهة للوظيفة 

sysrq» مع وجود خيارات متنوعة للعمل. 
Page Setup... اعدادات الطباعة

Print Preview... مشابه للتطبيقات الاخرى
Print... الطباعة

طباعة  او  الملصق  طباعة   ...More Print Functions
رزمة  

Image Properties... المعلومات المتعلقة بالصورة مثل 
الحجم و الفورمات

Preferences...التفضيلات 
الحالية  الملفات  بفتح  القيام   ...Open Recent Files
نهائيا القائمة  او  التطبيقات  من  الخــروج   ...Exit
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The Edit Menu قائمة التحرير  
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تو

فو
 ال

ف
تر

اح
 و 

لم
تع Undo Before... التراجع عن كل الفعاليات التي تم 

القيام بها سابقا 
Redo To... اشارة الى ما سبق

Clear Undo/Redo History... ازالة كل المدخلات من 
القوائم التي سبق ذكرها

Repeat... القيام باعادة الفعالية الاخيرة 
Cut... القيام بقص الكائن الذي تم اختياره و الصاقه 

في مكان آخر.
في  طبعه  اعادة  و  الكائن  بطبع  القيام   ...Copy

مكان آخر 
Paste... القيام بلصق الكائن

بدون  المعلومات  مسح  او  بأخلاء  القيام   ...Clear
التأثير على المحتوى

Duplicate... القيام بصنع ملف او مضاعفته. 
للتعامل  خيارات  ثلاثة  بتوفير  القيام   ...Clipboard

مع الملف
Crop... القيام بتصغير او تحجيم الصورة

Rotate & Flip... خيارات متنوعة من قبيل اداة النقل 
الحر 

Place as Base Image... استبدال الصورة الاساسية 
مع ملف جديد  

Fill... القيام بفتح مربع حوار ملء الالوان
او  يذوي  الصور  من  جزء  بجعل  القيام   ...Fade-out

تخف اضائته 
القيام بتشكيل صورة   ...Stitch Scanned Images

عن طريق مزج صورتين معا
Trace Edges... القيام بصنع شكل من صورة

Edit Active Objects Only... تكون هذه الاداة مفيدة 
الاخر  احدها  يزاحم  الرسومية  الكائنات  كانت  اذا 
القيام  بعد  نريده  الذي  العنصر  بتحرير  فنقوم 

بتنشيطه
Mask Mode... التحكم بأعدادات القناع ( الماسك) 
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The Adjust Menu قائمة التعديل    
القوائم  بأظهار  القيام   ...Auto-Process
سلسلة  تطبيق  يتم  حيث  الفرعية 

التعديلات الآلية على الصورة 
و  المؤثرات  بعض  بأضافة  القيام   ...Style

الجماليات على الصورة 
Brightness & Contrast... القيام بالتحكم 

باللمعان و الاضاءة 
على  المطلوب  بالتعديل  القيام   ...Level

الضوء و الظل
Hue & Saturation... القيام بعملية موازنة 

الضوء
البريق  القيام بتعديل درجة   ...Tone Map
او  اللون  توزيع  على  بالاستناد  الاعتام  او 

الالوان في الصورة
القيام   ...Highlight Midtone Shadow
الثلاثة)  الالان  (مستويات  الالوان  بتعديل 

بصورة منفصلة الواحد عن الاخر.
Color Balance... القيام بموازنة الالوان

بتعديل  القيام   ...Color Adjustment
الالوان

بأستبدال  القيام   ...Color Replacement
الالوان 

Invert... القيام تثبيت اللون و الصبغة
او  بوستر  الــى  التحويل   ...Posterize

ملصق
البيكسلات  بفصل  القيام   ...Threshold

في الصورة الى اسود و ابيض
تبعا  الموازنة  بعملية  القيام   ...Equalize

للضوء و الظل 
Calculation... القيام بمزج صورتين معا

بتعديل  القيام   ...Scanned Image Fix
سبع  في  السكانر  عن  المأخزوذة  الصورة 

مراحل
على  التعديل  بأجراء  القيام   ...Resize

حجم الصورة
Resolution... القيام بالتحكم بدرجة قوة 

الصورة و وضوحها
بأضافة  القيام   ...Expand Canvas
بيكسلات اضافية الى مكونات الصورة و 

حوافها
بتحويل  القيام   ...Convert Data Type

فورمات الصورة الى صيغة اخرى
لوح  او  ــوان  الال منضدة   ...Color Table



13

١٠
ت 

باك
ام

تو
فو

 ال
ف

تر
اح

 و 
لم

تع
The Edit Menu قائمة التحرير  

تم  التي  الفعاليات  كل  عن  التراجع   ...Undo Before
القيام بها سابقا 

Redo To... اشارة الى ما سبق
من  المدخلات  كل  ازالة   ...Clear Undo/Redo History

القوائم التي سبق ذكرها
Repeat... القيام باعادة الفعالية الاخيرة 

Cut... القيام بقص الكائن الذي تم اختياره و الصاقه 
في مكان آخر.

Copy... القيام بطبع الكائن و اعادة طبعه في مكان 
آخر 

Paste... القيام بلصق الكائن
Clear... القيام بأخلاء او مسح المعلومات بدون التأثير 

على المحتوى
Duplicate... القيام بصنع ملف او مضاعفته. 

Clipboard... القيام بتوفير ثلاثة خيارات للتعامل مع 
الملف

Crop... القيام بتصغير او تحجيم الصورة
Rotate & Flip... خيارات متنوعة من قبيل اداة النقل 

الحر 
Place as Base Image... استبدال الصورة الاساسية 

مع ملف جديد  
Fill... القيام بفتح مربع حوار ملء الالوان

Fade-out... القيام بجعل جزء من الصور يذوي او تخف 
اضائته 

Stitch Scanned Images... القيام بتشكيل صورة عن 
طريق مزج صورتين معا

Trace Edges... القيام بصنع شكل من صورة
Edit Active Objects Only... تكون هذه الاداة مفيدة اذا 
كانت الكائنات الرسومية يزاحم احدها الاخر فنقوم 

بتحرير العنصر الذي نريده بعد القيام بتنشيطه
Mask Mode... التحكم بأعدادات القناع ( الماسك) 
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The Photo Menu قائمة الصورة
السريع  بالتعديل  القيام   ...ExpressFix

على الصور
على  بالتعديل  القيام   ...Auto-Process

الصور و لكن مع خيارات قليلة 
Brightness & Contrast... القيام بالتعديل 

على الاضاءة و التباين
و  المؤثرات  بعض  بأضافة  القيام   ...Level

الجماليات على الصورة
و  بالتعديل  القيام   ...Enhance Lighting

التصحيح على اخطاء الاضاءة 
الصورة  تركيز  بتصحيح  القيام   ...Focus

او تشتيتها
Color Balance... القيام بموازنة و تصحيح 

اللون 
من  لون  أي  بحذف  القيام   ...Color Cast

اجل وضع او استبدال لون آخر
عمليات  القيام   ...Hue & Saturation

التعديل اللوني
خيار  مهام  بنفس  القيام   ...Tone Map

التعديل
القيام   ...Highlight Midtone Shadow

بنفس مهمات خيار التعديل
Remove Red Eye... القيام بأزالة الوميض 

الاحمر من العين
Blur... القيام بتشكيلات التشتيت

حدة  بتشكيلات  القيام   ...Sharpen
الصورة

من  التشويش  بأزالة  القيام   ...Noise
الصورة

مواصفات  بتحسين  القيام   ...Enhance
عمليات  بسبعة  المرور  خلال  من  الصورة 

للفلترة
خيارات  بتوفير  القيم   ...Lens Filters
تصفية الرؤية كما هو الحال في الكاميرا

Lens Distortion... القيام بأزالة التشويش 
الذي تحدثه العدسات ذات المدى الضيق

بتوحيد  القيام   ...High Dynamic Range
اجزاء الصورة

و  الاطار  بأضافة  القيام   ...Photo Frame
الظل و النص للصورة
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The Effect Menu قائمة المؤثرات

All... القيام بفتح جميع المؤثرات من خلال قائمة 
رئيسية تشتمل على فروع المؤثرات

في  التحكم  مؤثرات  بأضافة  القيام   ...Lighting
الضوء

ما  اقرب  الى  الصورة  بتحويل  القيام   ...Artistic
يكون العمل الفني ( الرسم).

Distort... القيام بأحداث تشويه فني في الصورة
و  المــلء  بتنشيط  القيام   ...Fillls & Textures

النسيج ( الخامات).
 ) الرباعي  المنظر  بتنشيط  القيام   ...Creative
الكاليدوسكوب) و قلب الصورة و خيارات الرسوم 

المتحركة.
للصور  التعديل  خيار  بتفعيل  القيام   ...Video

المأخوذة من الفيديو.
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The Selection Menu قائمة الاختيار 
اخفاء  و  بأظهار  القيام   ...Show/Hide Selection

الكائن الرسومي
None... القيام بأبطال جميع الاختيارات

All... القيام بتفعيل جميع الاختيارات
Invert...القيام بأختيار جميع المناطق التي لم يتم 

اختيارها 
تم  الذي  الكائن  حول  حد  بخلق  القيام   ...Border

اختياره
Expand/Shrink... القيام بتفعيل خيارات التوسيع 

و التقليص بالنسبة للكائن الرسومي
البيكسلات  اختيار  بتفعيل  القيام   ...Similar

المشابهة لتلك التي تم اختيارها للتو
Soften... القيام بتخفيف حواف الكائن الرسومي

مقادير  بأختيار  اليام   ...Select by Color Range
من الصورة تستند اساسا الى مقدار التشابه في 

اللون
Convert to Object... التحويل الى كائن رسومي

الصورة  بحفظ  القيام   ...Preserve Base Image
الاصلية 

Store Selection... القيام بحفظ اعدادات و خيارات 
الصورة لحين استخدامها مرة اخرى 

الذي  الاختيار  بتحميل  القيام   ...Load Selection
قمت بخزنه مسبقا

ذات  الصورة  بأستيراد  القيام   ...Import Selection
تدرج الرمادي كقناع

ذات  الصور  بتصدير  القيام   ...Export Selection
التدرج الرمادي كقناع

Copy Selection to Object Library... القيام بحفظ 
اعدادات القناع 
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الكائنات  قائمة   The Object Menu

الرسومية
Insert Image Object... و تمثل عدة طرق لصنع او 

فتح كائن جديد
Duplicate... القيام بمضاعفة الكائن الرسومي او 

الصورة
القيام بعملية مزج الكائن المستحدث   ...Merge

الى الكائن الاصل
Merge All... القيام بمزج كل محتويات العمل الى 

القاعدة او الاصل
عنصر  بمزج  القيام   ...Merge as Single Object

واحد فقط
Delete... القيام بالحذف

Select All Objects….اقيام بأختيار كل الكائنات
تنشيط  بعدم  القيام   ...Deselect All Objects

خيار اختيار الكائنات  
الرسومي  الكائن  حواف  بمزج  القيام   ...Defringe

مع الخلفية
Match Background Color... القيام بمطابقة لون 
الخلفية ففي بعض المواقف يتم مزج الكائن مع 

خلفيته و ليس الخلفية التي قمنا بتعيينها
Extract Object... القيام بصنع كائن رسومي من 

صورة
التحرير المطلوبة  القيام بعمليات   ...Edit Object

على الكائن الرسومي او الصورة
او  الرسوم  احناء  او  طي  او  بثني  اقيام   ...Wrap

النصوص او المسارات 
او تفليم  القيام بعملية تشذيب   ...Trim Object

الكائن الرسومي
Convert Object Type... القيام بعملية تحول صيغ 

او فورمات الكائن الرسومي
الكائنات  تجميع  او  بتوحيد  القيام   ...Group
معهم  التعامل  من  تتمكن  لكي  الرسومية 

جميعا 
الكائنات  توحيد  بفك  القيام   ...Ungroup

الرسومية
كائنات  عدة  محاذاة  بعملية  القيام   ...Align

رسومية عموديا و افقيا
امام  الواحد  الكائنات  بترتيب  القيام   ...Arrange

الاخر او خلفه
الى  بالنسبة  الظل  بموضعة  القيام   ...Shadow
و هنا توجد خيرات لا محدودة في  كائن رسومي 

هذه العملية 
Split Shadow...  القيام بشطر الظل 

بأستبدال كائن رسومي  القيام   ...Import Object
مكان آخر

في  رسومي  كائن  بخزن  اقيام   ...Export Object
مكان ما

Copy to Object Library... القيام بأضافة الكائن 
او طباعته الى مكتية صور البرنامج

معرفته  تريد  ما  كل  ويتضمن   ...Properties
الكائن  او  الصورة  عن  معلومات  و  خواص  من 

الرسومي
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The Web Menu قائمة موقع الويب
HTML Text Object... اضافة النص الى موقعك

Link Object... القيام بربط الصورة و الحدث في 
موقعك

Rollover... القيام بصنع ازرار الويب 
هو  المكونات  مصمم   ...Component Designer
عبارة عن مجموعة من الرزم الجاهزة التي يمكن 

الافادة من محتوياتها في تصميم موقعك
الخلفيات  مصمم   ...Background Designer
بواسطتها  يمكن  جاهزة  رزمة  عن  عبارة  هو  و 

تصميم الخلفية التي تريد من اجل موقعك
يقوم  هو  و  الازرار  مصمم   ...Button Designer

بتصميم الازرار لصفحة الويب 
Web Properties... مواصفات صفحة الويب

القيام   ...Check HTML Rendering Errors
في  المحتملة  الاخطاء  عن  التدقيق  و  بالفحص 

تصيير موقع الويب
Web Attributes... و هو القسم الخاص بتغيير 
و  الازرار  و  الروابط  مثل  الويب  صفحة  خيارات 

الخلفية
Grid and Partition... الشبكة و التقسيم 

ضمن  الصورة  بتحريك  القيام   ...Shift Image
الاطار 

صورة  بخلق  القيام   ...Create Seamless Tile
جديدة من الصورة الموجودة حاليا 

Object Editor Manager... يقوم بأظهار و اخفاء 
و تحرير و ادارة الصور

Helper Program... مساعد البرنامج الذي يقوم 
فيه  توجد  الذي  ديسك  الهارد  موقع  بتحديد 

الصورة التي تريد استدعائها
تقوم  التي  الصور  حافظة   ...Image Optimizer
بمهمة حفظ الصور و ارسالها الى الانترنيت او 

البريد الاليكتروني
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The View Menu قائمة المشاهدة

في  جديدة  نافذة  بفتح  القيام   ...Add a View
نفس البرنامج

الحجم  على  بالتعديل  القيام   ...Actual View
حتى ١٠٠٪

Maximize at Actual View... التكبير الى الحجم 
الفعلي ليطابق مساحة العمل

Zoom... التكبير الى ما بين ١٪-٦٠٠٪
Fit in Window... المطابقة مع النافذة

الشاشة عندما تملأ صورك  Full Screen... ملء 
 ESC الشاشة بكاملها فتقوم بالضغط على

الصورة  اظهار  و  اخفاء   ...Show Base Image
الاصلية 

الاضــواء  بتفعيل  القيام   ...Show Marquee
المتحركة المحيطة بالكائن

بأظهار  القيام   ...Show Box Around Objects
مربع حول الكائنات الرسومية 

Show Ruler... القيام بأظهار المسطرة
خطوط  بأظهار  القيام   ...Show Slice Line

التقطيع
Show Image Map... تفعيل تقسيمات الصورة 

باستخدام اداة خارطة الصورة
Guidelines and Grid... اظهار خطوط الارشاد  

The Help Menu قائمة المساعدة   
ملف  بفتح  القيام   ...PhotoImpact Help

المساعدة الملحق بالبرنامج
Product Updates on the Web... تحديث المنتج 

على الانترنيت  
القابلة  المنتوجات  تحميل   ...Smart Download
و  الفرش  و  الصور  مثل  التحميل  و  للنقل 

المؤثرات
على  المنتج  تسجيل   ...Online Registration

الانترنيت من اجل شموله بالترقية
او  النظام  مواصفات   ...System Properties

الحاسبة التي تعمل عليها 
المتعلقة  الامـــور   ...About PhotoImpact

بالبرنامج
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مم تتكون واجهة البرنامج؟؟
. و بأمكانك ان تقوم    ULEAD PHOTOIMPACT او تثبيت اشرطة الادوات في برنامج من الممكن تعويم 
بأظهار او اخفاء اشرطة الادوات او حتى ترقيتها من اجل راحة و سهولة العمل في البرنامج . ان بعض 
.Panel Manager الاشرطة يمكن فتحها او اغلاقها حسبما تتطلبه الحاجة و ذلك عن طريق نقر الازرار في

و لنستعرض معا اشرطة و لوحات الادوات في هذا البرنامج.
١ – شريط الادوات القياسي: و يحتوي على اغلب الاوامر و الادوات التي يحتاجها المستخدم.من الممكن 
ترقية شريط   الممكن  Panel Manager. من  امتداد حافة  او على  الادوات  بتعويمها تحت شريط  تقوم  ان 

الادوات عن طريق الايعاز التالي:
File> Preferences > Customize Standard Toolbar
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واجهة البرنامج  و متعلقاتها
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٢ - شريط الخيارات: و يقدم للمستخدم خيارات الادوات حيث نلاحظ انه يتغير بتغير الاداة التي 
يقوم المستخدم بأختيارها.

٣ – لوحة الادوات: و توفر للمستخدم كل امكانيات تحرير العمل الفني التي يحتاج اليها قدر تعلق 
الامر بالخواص الدقيقة للصورة.

٤ - لوحة ادارة العمل:من الممكن بالنسبة للمستخدم تعويم او اغلاق لوحة ادارة العمل ، و على 
العموم فهذه اللوحة تعطيك ٩ مداخل بضمنها الطبقات Layer . و للتمكن من الوصول الى او اخفاء 

لوحة ادارة العمل اتبع الابعاز التالي:

.Workspace: Panel Manager 

٥ - Easy Palette: تحتوي هذه المنسدلة على عدد لا يحصى من المؤثرات و الكائنات الرسومية من 
اجل الاستعانة بها في مشاريعك و من اجل تطبيق التأثير او اضافة الكائن الرسومي منها ، قم فقط 

بعملية السحب و الافلات على الصورة او مشروع العمل في مساحة العمل.
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٦ – نوع البيانات data type : و يمكن بواسطتها اظهار القوائم الفرعية لتغيير الصورة اتارة 
الى نوع آخر من الصور. و يتم ذلك بالاعتماد على صيغة او فورمات الصورة الحالية و الذي يمكنك من 

التحويل الى أي من الصيغ التالية:
* الاسود و الابيض.
* تدرجات الرمادي.

* صورة ذات ١٦ لون.
* صورة ذات ٢٥٦ لون.

* صورة للنشر على الويب.
.RGB الوان *

* ١٦ لون بتدرجات اللون الرمادي.

.RGB ٤٨ لون بنظام *
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٧ – نظام خواص و مواصفات الصورة: يختص مربع الحوار هذا بتقديم تقرير كامل عن خواص 
و مواصفات الصورة.

 photoimpact  و التي هي  photoimpact ٨ – الانتقالة: من اجل الانتقال الى البرامج المرفقة ببرنامج
.ulead GIF animator  و  albume
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الواجهة القياسية و الواجهة الاساسية

الرئيسية  الواجهة  بأستخدام  البدء  فبأمكانك  الفوتوامباكت   لبرنامج  مبتدئا  مستخدما  كنت  اذا 
للبرنامج و  التي تتميز بمواصفات مبسطة لأغلب المهام التي يمكن للبرنامج تأديتها.و سوف تتمكن 
التحكم في   ، ذلك  و بضمن  الاحتراف  التي ستضعك على طريق  التحكم بالخصائص الاساسية  من 

خصائص الصور ، و ادوات تحرير الصور، و الفلاتر و المؤثرات الشائعة الاستعمال.
و عندما تنتقل الى طور الاحتراف و تكتسب المزيد من الخبرة في التعامل مع هذا البرنامج ، فسوف يكون 
بأمكانك الانتقال او التغيير الى الواجهة القياسية للبرنامج و التي تتضمن مهام اكثر و ادوات اكثر 

تخصصا .

للانتقال بين الواجهتين قم بالنقر على workspace  في شريط القوائم .

القوائم و اللوحات الفرعية 

لوحة الادوات: ذكرنا سابقا ان لوحة الادوات توفر للمستخدم كل امكانيات تحرير العمل الفني التي 
يحتاج اليها قدر تعلق الامر بالخواص الدقيقة للصورة.و نظرا لأهميتها فسيكون شرحنا بخصوصها 

مركزا قدر الامكان.
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تتكون لوحة الادوات مما يلي:

اداة الالتقاط:                      بالامكان استخدام اداة الالتقاط من اجل تحريك ما يتم انتخابه او 
اختياره من كائنات رسومية . 

اداة التحديد:                                       و تتكون اداة التحديد من اربعة ادوات فرعية و هي:

دائرية  او  او بيضوية  او تخليق اشكال مربعة  اداة الاختيار من صنع  أداة الاختيار:            تمكنك   -  ١
لأستخدامها في العمل الفني و الرسومي.و هو امر جيد بالنسبة للاشكال التي تمتلك بعدا او شكلا 

هندسيا ثابتا .

عند تفعيل اداة الاختيار نلاحظ ظهور التعديلات اعلاه حيث ان mode  يعني اختيار شكل التقطيع 
سواء كان بيضوي او مبع او مستطيل او دائري ، اما shape  فيعني تفعيل اشكال التقطيع في حين ان 
fixed size  يعني اختيار او ادخال حجم العمل الفني بالبكسل اما soft edge  فيقوم بتنعيم حواف 

العمل الفني او المنطقة التي تم تحديدها.

٢ - اداة الانشوطة:              تمكنك اداة الانشوطة من القيام بأختيار و تحديد الاشكال التي لا تمتلك 
شكلا هندسيا ثابتا مثل بتلات و اوراق الازهار . اما شريط الخيارات الخاص بهذه اداة الاداة فيرينا جملة 

من الامور 
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يسمح لنا mode  بأختيار  التفعيل اما smart lasso  فيسمح لنا بمهمة مشابهة لمهمة الخط الممغنط 
الذي يلتصق بحدود الشكل الذي نريد تقطيعه ، 

٣ - العصا السحرية:             تسمح لنا اداة العصا السحرية بأختيار مكان قطع و ازالة اجزاء من الكائن 
او الصورة بالاعتماد على اللون او الكثافة اللونية.و ما يزيد سهولة استخدامها كون الصورة تحتوي على 

قدر كبير من الكثافات اللونية المتجانسة او البياض المحيط بالصورة المراد قطعها.

٤ - اداة ترسيم المنحنيات:

اداة ترسيم المنحنيات تسمح للمستخدم برسم او وضع الحدود التي نريدها من اجل اكمال عملية القطع.
من الممكن استخدام هذه الاداة لصنع المسار الذي تريد اقتطاعه من الصورة او الكائن الرسومي.

٥ - اداة التجسيم الثنائي و الثلاثي:             تسمح هذه الاداة برسم اسمات التي نحتاج اليها و من 
ثم القيام بتجسيمها كأشكال ثنائية الابعاد او ثلاثية الابعاد.و عند النقر على المثلث الاسود الصغير 

سوف نلاحظ انبثاق منسدلة تحتوي على الادوات التالية:

أ - اداة رسم المسارات اتصة برسم المسارات و الاطارات و التحكم بها سواء كانت اشكال مصمتة او 
مفرغة او اسهم او منحنيات.

 

ب ـ              التحكم برسم و لون و تجسيم المسارات سواء كانت مصمتة او مفرغة.و نلاحظ ارتباط هذه 
الاداة عبر مربع الحوار بالمعرض و المكتبة في البرنامج.

٦ - اداة النص:             عند النقر على هذه الاداة يظهر لنا الشريط ادناه الذي يتيح لنا التحكم الكامل 
التخطيط  و  السمك  و  الامالة  مقدار  و  حجمه  و  نوعه  و  الخط  بـ  التحكم  من  نتمكن  حيث  بالنص 
السفلي و المحاذاة و اللون و التجسيم اذا كنا نريده ثنائيا او ثلاثيا و الحد المحيط بالنص او الكتابة بالاضافة 
لذلك  تبعا  فنقوم  العربية  اللغة  تدعم  لا  لكنها  و  المكتبة  و  المعرض  مفردات  استدعاء  امكانية  الى 

بالاستعانة ببرنامج ابو رشيد او البرامج الداعمة لذلك.
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٧ - اداة التحجيم:  و تحتوي هذه الاداة على نوعين من تحجيم الصور فالتحجيم اما ان يكون اعتياديا او 
منظوريا

أ - التحجيم الاعتيادي:حيث يتم و بكل سهولة استبعاد العناصر الغير مرغوب فيها من الصورة  و 

يكون الشكل النهائي هندسيا منتظما مربعا او مستطيلا.              حيث يظهر شريط الخيارات ادناه:

ب - التحجيم المنظوري : حيث يتم التلاعب بالشكل الهندسي و لا يشترط ان يكون القطع ذو شكل 
مربع او مستطيل او هندسي منتظم.            حيث يظهر شريط الخيارات ادناه:

٨ - اداة النقل و التحويل الحر:             حيث نتمكن بواسطة هذه الاداة من تحديد حجم و ادارة و امالة و 
قلب و تدوير الصورة او الكائن الرسومي الذي نريد.و لدى النقر على هذه الاداة يظهر لنا الشريط التالي:

امكانية تحديد  بالدرجة مع  التحويل  و مقدار  الاستدارة  و  الامالة  و  التحويل  امكانيات طرق  لنا  يتبين 
الطول و العرض للصورة او الكائن الرسومي.

٩ - ادوات الرتوش:و نظرا لأهمية هذه الاداة سوف يكون الشرح عليها مسهبا بعض الشيء.

تتكون هذه الاداة من الاجزاء التالية :
١ -          مزيل العين الحمراء: يتسبب فلاش الكاميرا بظهور نوع من التلوين الغير المرغوب فيه في عين 
الانسان عند اخذ او التقاط الصور . و مهمة هذه الاداة هي التخلص نهائيا من تأثير العين الحمراء في 

الصورة.بالاستعانة بشريط الادوات التالي و الخاص بمزيل العين الحمراء:

٢ -           معامل التنوير : حيث يقوم معامل التنوير بزيادة مساحة الضوء في الصورة او بمعنى آخر 
الاضاءة على حساب الالوان الغامقة او المعتمة . و تؤدي هذه الاداة مهمتها بالاعتماد على شريط الادوات 

التالي:
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٣ -         معامل الاعتام ، فعلى العكس من المهمة التي تؤديها اداة معامل التنوير حيث ان معامل الاعتام 
يقوم بتظليل المناطق المضيئة في مهمة معاكسة تماما لمعامل التنوير و حسب ما يبينه شريط الادوات 

ادناه:

او مكونات  العامل بأضافة شيء من الضبابية على حدود  -        معامل الضباب : حيث يقوم هذا   ٤
الكائن الرسومي او الصورة الداخلية بحيث تصبح بعيدة من التركيز اللون و قريبة من الضبابية و حسب 

الامكانيات التي توفرها الاداة التالية ادناه:

٥ -         معامل تقوية الصورة : حيث قوم هذا المعامل بمهمة تختلف تماما عن سابقه ، ذلك انه يزيد 
حسب  و  مجسمة  شبه  حالة  في  هي  و  الدقيقة  التفاصيل  كل  نتبين  بحيث  الصورة  وضوح  قوة  من 

الامكانيات التي توفرها الاداة التالية ادناه:

٦ -         اداة ضبط الالوان: بالاعتماد على اللوحة اللونية او الكائن الصوري او الرسومي ، تقوم هذه الاداة 
بأضاءة او اعتام او زيادة سطوع و بريق اللون في منطقة محددة بعينها و حسب الامكانات التي توفرها 

الاداة التالية ادناه:

٧ -          اداة تشويه الصبغة: تقوم هذه الاداة بنفس الاثر الذي يتركه الاصبع لدى مروره على مساحة 
لونية معينة .

٨-           تقوم هذه الاداة بزيادة السطوع في منطقة يتم تحديدها تبعا لأختيار المصمم بالاضافة الى 
تغيير قنوات اللون في اللوحة.

٩-           اداة الاستبيان : تقوم هذه الاداة بتوفير معلومات عن الالوان و مقدار الصبغة و السطوع في كل 
قسم تمر عليه الاداة بالاضافة الى امكانية احداث تشويه يمكن الافادة منه حسب رغبة المصمم.

١٠ -           اداة التشويه النقطي : بأستخدام هذه الاداة يمكن احداث تشويه مشابه لأحداث نقاط ذات 
لون مركز من الممكن ان تخدم الغرض الفني حسب رؤية المصمم.

ازالة التجاعيد و  ازالة التجاعيد و الشقوق: من الممكن استخدام هذه الاداة من اجل  -          اداة   ١١
الشقوق « الدعك» من الصورة بغية معالجتها.

١٢ -           اداة ازالة التشويش : من الممكن استخدام هذه الاداة من اجل ازالة التشويش من الصور التي 
يتم سحبها بواسطة السكانر.

١٣ -           اداة القلم الناسخ: من الممكن استخدام هذه الاداة من اجل نقل او تحويل لون الصبغة من 
لون الى آخر .
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١٤ -            قلم التلوين: تستخدم هذه الاداة في تلوين اجزاء الصورة.

تحتوي شريط ادوات التلوين على الادوات التالية:

١ -           فرشاة التلوين: تقوم هذه الفرشاة بتوزيع اللون على السطح او الصفحة المعدة لهذا الغرض 
و حسب الخيارات التي يوفرها الشريط التالي:

٢ -          اداة البخاخ: عمل هذه الاداة شبيه بعمل اداة البخاخ.

٣ -           الرسم بقلم التخطيط : عمل هذه الاداة شبيه بالاثر الذي يتركه قلم الرصاص حيث يمكن 
القلم بواسطة اختيار نسيج كما في  امكانية تعديل ضربة  الى وجود  بالاضافة  الاثر  اعدادات  تغيير 

اللوحة التالية:

٤ -           اداة التلوين بالفحم .

٥ -           اداة التلوين و الرسم بالطباشير.

٦ -          اداة الرسم بقلم الرصاص.

٧ -            اداة الرسم بقلم الماجك العريض « ماركر».

٨ -           اداة الرسم بالالوان الزيتية.
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٩ -            اداة الرسم بالكائنات الرسومية الدقيقة:من اجل تصور ما تؤديه هذه اداة انظر الى الصورة  
التالية ادناه:

                                                      
١٠ -            اداة تقطير الماء : تقوم هذه الاداة بعمل الرطوبة الزائدة المضافة الى الصبغة .

١١ -             اداة التلوين الناقص : كماهو واضح من شكل الفرشاة الذي يوحى بأن الفرشاة لم تتشبع 
بكمية كافية من اللون و بالتالي فهي تترك اثرا واضحا لدى المرور على سطح الصورة.

١٢ -          اداة استبدال لون الخلفية: تقوم هذه الاداة بالتقاط لون و من ثم استبدله بلون الخلفية في 
الصورة.

توجدهذه الاداة بشكل اداة الختم و يمكن الاستعانة بها في توليد اشكال جاهزة يمكن الوصول اليها عن 
طريق النقرعلى الاداة ثم اختيار الطابع select stamp  لتظهر لنا هذه المنسدلة التي تحمل رسوميات 

جاهزة يمكن التحكم بتوزيعها و شفافيتها و مساراتها.

١٠
ت 

باك
ام

تو
فو

 ال
ف

تر
اح

 و 
لم

تع
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لأدوات النسخ جميعها مهمة واحدة و ان اختلفت في اكمالها ، و يأتي الاختلاف تبعا لرغبة المصمم و 
ضرورة العمل الفني.  تقوم هذه الادوات بنسخ الصورة او الكائن الرسومي وهذه الادوات هي :

١ -             النسخ باللمس.

٢ -             اداة النسخ بالفرشاة.

٣ -             اداة النسخ بالبخاخ.

٤ -             اداة النسخ بقلم التخطيط .

٥ -             اداة النسخ بقلم الفحم.

٦ -             اداة النسخ بقلم الرصاص.

٧ -             اداة النسخ بقلم الماجيك « ماركر».

٨ -             اداة النسخ باللون الزيتي.

٩ -             اداة النسخ بفرشاة التلوين الناقص.

١٠ -             اداة النسخ بالطباشير.

و كقاعدة عامة فأن مربع او شريط التحكم بهذه الادوات يكون نفس النموذج ادناه.
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تستخدم ادام المسح « الممحاة» في مسح المساحات الملونة و تحديد العمل الفني او الكائن الرسومي او 
الصوري بشكل آخر ، و بالاختصار فأن عملها يرتكز على ازالة اجزاء من الصورة او الكائن الرسومي.

تتكون اداة الممحاة من قسمين:

١ - الممحاة الاعتيادية :                تسمح لنا الممحاة بصورتها الاعتيادية  بمسح اجزاء من الصورة و بدرجات 
مختلفة و بضغوط فرش المحو اتلفة و لهذا فهي تؤثر على شفافية المناطق التي تم محوها.و من الممكن 

استعادة المناطق التي تم حذفها قبل التشذيب او عملية المحو.

 
٢ - الممحاة السحرية:              بأستخدام الممحاة السحرية تستطيع ان تحذف الدرجات المتشابهة من 

الكثافات اللونية في الصورة.

تستخدم ادوات التعبئة في برنامج الفوتوامباكت بصورة عامة من اجل ملء او تعبئة المناطق التي نقوم 
بتحديدها بالالوان او النسيج « الخامات» و بالاعتماد على هذه الاداة و تفريعاتها نستطيع ان نحقق ملء 

لون مزدوج و متدرج و مصمت و شفاف .

: الى  الادوات  هذه  تنقسم  و 

فقط. واحد  بلون  اللونية  الماحية  بملء  الاداة  هذه  تقوم  و  الملء:         سطل   -  ١

الخطي: بالتدرج  التعبئة  و  الملء  اداة   -  ٢

أداة المسح « الممحاة»
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الصبغة  في  متدرجة  بألوان  المفرغة  المساحة  او  الكائن  بملء  الاداة  هذه  تقوم  حيث 
نهاية  الى  و  نختارها  التي  المنطقة  من  تبدأ  مستقيمة  خطوط  شكل  على  اللونية 

. المساحة 

التعبئة  و  الملء  الاداة بعملية  الرباعية:           تقوم هذه  المتدرجة  التعبئة  او  الملء  اداة   -  ٣
بالزوايا  انتهاء  و  المركز  من  الملء  نقطة  يبدأ  و  رباعي  بشكل  المؤشر  يكون  حيث 

و  الملء  بعملية  الاداة  هذه  تقوم  الدائرية:           المتدرجة  التعبئة  او  الملء  اداة   -  ٤
بالمحيد  انتهاء  و  الركز  من  الملء  نقطة  يبدأ  و  دائري  بشكل  المؤشر  يكون  حيث  التعبئة 

الدائرة.  يشكل  الذي 

تعبئة  بمهمة  الاداة  هذه  تقوم  النسيج»:                 » بالخامة  التعبئة  او  الملء  اداة   -  ٥
خلال  من  و  الخامات.  او  بالنسيج  اللونية  المساحات  و  الفراغات  و  الخلفيات  و  الصور 
مواصفات  و  الحجم  و  الملء  اتجاه  و  النسيج  بمواصفات  التحكم  يمكن  الادوات  شريط 

لملء. ا

في  الموجودة  و  المفعلة  الصورة  من  تريده  الذي  الجزء  بتضخيم  التكبير  اداة  لك  تسمح 
العمل. مساحة 

على: التكبير  معامل  ادوات  شريط  يحتوي 

اجراؤه  يتم  الذي  الحالي  التكبير  بتعديل  يقوم  الذي  و   :  zoom leve التكبير  مستوى   -  ١
لذلك. المؤشر  تقديم  و  ارجاع  و  سحب  طريق  عن  ذلك  و  الصورة  على 

الحقيقي  الحجم  الى  صولا  التكبير  درجة   تكثير  او  بقليل  تقوم  التي  و   :  view المعاينة   -  ٢
. ة ر للصو

نسبة  بأتخاذ  اوتوماتيكيا  تقوم  لكي  تفعيلها  يتم  و   :  adjust menu التعديل نافذة   -  ٣
الصورة. عليها  تكون  التي  التكبير 
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أدوات القطارة و القياس
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بعد  الصورة  في  اللون  على  بالنقر  ذلك  و  الالوان  بأختيار  تسمح  القطارة         اداة  ان 
قيد  سيصبح  الذي  اللون  يكون  سوف  بأختياره  قمت  الذي  اللون  ان   . الاداة  تفعيل 
المهام  المتعدد  الادوات  شريط  ان  التلوين.  اداة  بتفعيل  تقوم  عندما  للفرشاة  الاستخدام 
تكشف  فهي  بالاسود  المحاطة  الالوان  اما  . اليها  تضيف  ان  يمكن  الوان   ٨ على  يحتوي 

بأختياره.  القطارة  اداة  قامت  الذي    RGB قيم  مقادير 

المعطاة  الزاوية  و  الارتفاع  و  العرض  و  الطول  لقياس  مخصصة  فهي  القياس         اداة  اما 
الصورة. في  مقطع  او  مساحة  لكل 

الانترنيت  مواقع  بتصميم  يتعلق  فيما  جدا  مهمة  بصددها  نحن  التي  التشريح        اداة 
. الشيء  بعض  شرحها  في  الاسهاب  يجري  سوف  لذا  و  الفوتوامباكت  برنامج  بواسطة 

و  اقسام. او  اجزاء  الى  الصورة  تقطيع  بواسطتها  يمكن  التقطيع  او  التشريح  اداة  ان 
نصوص  خلايا  و  الصورية  الخلايا  قبيل  من   ، الخلايا  انواع  من  العديد  هناك  ان  المعلوم  من 
الصور  من  قسم  لكل  يمكن  و   . الشفافية  خلايا  و  الرسومي  الكائن  خلايا  و  الهتمل 
اداة  على  بالنقر  و  الاخرى. الاقسام  عن  يختلف  مكان  في  يحفظ  ان  الاداة  بهذه  المقطعة 
من  ستتمكن  حيث  اعلاه  موضح  هو  كما  الاعدادات  لوحة  تنشيط  يتم  سوف  التقطيع 

. الفوري  التقطيع  او  الآلي  القطع  و  القطع  طريقة  مثل  التقطيع  اعدادات  تحديد 

 .

الاعدادات: من  جزء  كل  بشرح  الان  لنقم  و 

موجودة  معينة  خوارزمية  على  بناء  اقسام  الى  الصورة  بتقطيع  يقوم  الآلي:  التقطيع   -  ١
البرنامج. في 

به. التنقل  و  الصورة  من  معين  قسم  بألتقاط  يقوم   : الالتقاط   -  ٢

المستخدم. رغبة  حسب  التقطيع  خطوط  بأنشاء  يقوم   : الطريقة   -  ٣

استدعاؤها  ليسهل  البرنامج  ذاكرة  الى  الاخيرة  التعديل  اعدادات  بأضافة  القيام   -  ٤

أداة التقطيع « التشريح»
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فيتم  الاضافية  الخلايا  اما   . مربع  او  مستطيل  شكل  بأنشاء  يقوم   : المستطيل   -  ٥
المستطيل. طرفي  كلا  على  آليا  توليدها 

او  عموديتين  خليتين  بين   ) حدين  بين  طولي  قطع  خط  بأنشاء  يقوم  العمودي:  الخط   -  ٦
.( افقي  تقطيع  خطي  بين 

بين  او  افقيتين  خليتين  بين   ) حدين  بين  افقي  تقطيع  خط  بأنشاء  يقوم  الافقي:  الخط   -  ٧
عمودي). تقطيع  خطي 

الصورة. من  خط  بألغاء  يقوم  المسح:   -  ٨

الغير  ر  الاضرا تفادي  اجل  من  تفعيله  و  ه  اختيار  يتم  الويب:  موقع  محتويات  حماية   -  ٩
الويب. موقع  في  صورة  لكل  التقطيع  لخطوط  مقصود 

بفتح  قم   . متساوية  اجزاء  الى  الصورة  تقطيع  عن  عبارة  هو  و  الاختياري:  التقطيع   -  ١٠
الخلايا. حجوم  او  عدد  على  بالاعتماد  اما  خياراتك. بأعداد  لك  يسمح  الذي  ر  الحوا مربع 

عدد  بتحديد  قم   . الاعمدة  و  الصفوف  بأستخدام  الخلية  تقطيع   : الخلايا  حجم   -  ١١
الاعمدة. و  الصفوف  من  لكل  القيم  ادخال  طريق  عن  ذلك  و  للخلية  الصفوف  و  الاعمدة 

. البيكسل  على  اعتمادا  الصورة  بتقطيع  الايعاز  هذا  يقوم  البيكسلات:  عدد   -  ١٢

الصورة. في  التقطيع  خطوط  كل  بمسح  الايعاز  هذا  يقوم  الكل:  مسح   -  ١٣

التقطيع.  خط  بيانات  تصدير  او  بأستيراد  الايعاز  هذا  لك  يسمح  التقطيع:  بيانات   -  ١٤
الحالي  الخط  على  سابق  تقطيع  خط  بيانات  بتطبيق  تقوم  ان  تريد  عندما  مفيد  امر  هو  و 

للمستقبل. تقطيع  خط  بيانات  بخزن  تقوم  او 

الويب. صفحة  تحميل  في  المستغرق  الوقت  بأحتساب  القيام  الحجوم:  احتساب   -  ١٥

تم  الذي  الويب  موقع  بنية  داخل  في  الملف  حجم  بأظهار  يقوم  و  الملف:  حجم   -  ١٦
. فتحه

 

 

ارتباطات  ذت  محددة  مناطق  بأنشاء  للمستخدم  تسمح  الخارطة        - الصورة  اداة  ان 
قم  اولا.  الكائنات  انشاء  الى  الحاجة  بدون  انشائها  تعتزم  التي  الوثيقة  في  تشعبية 
استدم  و  الاعــداد  ادوات  لوحة  في  الخارطة   - للصورة  تريدها  التي  الاعــدادات   بضبط 
الصورة  خارطة  تحرير  و  انشاء  اجل  من  الادوات  خيارات  شريط  في  المتوفرة  الاعدادات 
بعض  مسهبا  لها  شرحنا  يكون  فسوف  الاداة  هذه  لأهمية  نظرا  و  انشائها.  تعتزم  التي 

. ء لشي ا

 

اعادة  و  التحجيم  و  الالتقاط  و  الاختيار  بمهام  الاداة  هذه  تقوم  و  الالتقاط:  اداة   -  ١
بأمكانم   ، ابعاد  اربعة  ذات  صورة  هناك  يكون  الوثيقة.عندما  في  الخارطة  الصورة  موضعة 
مفتاح  على  المستمر  الضغط  بالامكان  و   . الشكل  تغيير  اجل  من  العقد  تسحب  ان 

خرائط.  - صور  عدة  اختيار  اجل  من   CTRL

التي  الخارطة   - الصورة  انشاء  اجل  من  الاشكال  احد  باختيار  قم  الشكل:  اداة   -  ٢
. ها يد تر
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أداة الصورة - الخارطة
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تفادي  اجل  من  الخارطة   - الصورة  ترتيب  تقرر  ان  تستطيع  هنا  من  الطبقة:  ترتيب   -  ٣
الاختيار  هذا  بأنشائه.و  ستقوم  الذي  التشعبي  للارتباط  الاولوية  اعطاء  اجل  ن  و  التراكم 

طبقة. اختيار  يتم  لم  اذا  مفعل  غير  يكون  سوف 

صورة  بأختيار  صورية.قم  كائنات  عدة  مستوى  على  تتم  ان  يمكن  المحاذاة  ان  المحاذاة:   -  ٤
. الادوات  شريط  في  المحاذاة  اداة  على  انقر  و  خارطة   -

الادوات. اعدادات  لوحة  اظهار  او  بأخفاء  اللوحة  تقوم  اللوحة:   -  ٥

من    easy palette الى  الاضافة  من  يمكنك  الخيار  هذا  ان   :  easy palette الى  الاضافة   -  ٦
المستقبل. في  استدعائها  اجل 

 

 

لون  لأختيار  عليه  بالنقر  قم   . الخلفية  لون  بأظهار  الخيار  هذا  يقوم  الخلفية:  لون   -  ١
. خر آ

لونا  اختر  و  شئت  اذا  عليه  انقر   . المقدمة  لون  بأظهار  الخيار  هذا  يقوم   : المقدمة  لون   -  ٢
. خر آ

و  الابيض  الــى  الاســود  من  للتحويل  الاداة  هــذه  على  بالنقر  قم  التحويل:  اداة   -  ٣
  . لعكس با

الابيض. الى  الخلفية  لون  تحويل   -  ٤

الاسود. الى  الخلفية  لون  تحويل   -  ٥

بالعكس. و  الاسود  الى  الابيض  الخلفية  لون  تحويل   -  ٦

 

 

انشاؤها  تم  التي  و  العرضية  و  الطولية  التقطيع  خطوط  بأظهار  الاداة         هذه  تقوم 
التقطيع. اداة  بأستخدام  و  الرسومي  الكائن  او  الصورة  على 

: من  المقطعة  الخطوط  لون  اعدادات  تغير  ان  بالامكان  ملاحظة: 

preference - general -  web and internet

أداة اختيار لون الخلفية و المقدمة

أداة اظهار خطوط التقطيع
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الكائن  في  انشاؤها  يتم  التي  الخارطة   - الصورة  اخفاء  او  بأظهار  الاداة           هذه  تقوم 
الخارطة.  - الصورة  انشاء  اداة  بأستخدام  الرسومي 

التحكم  درجة  و  الصورة   - الخارطة  الوان  اعــدادات  ترتيب  و  وضع  بأمكانك  ملاحظة: 
: خلال  من  بالشفافية 

Preferences - General -  Web and Internet. 

التشغيل  وضع  و  الاعتيادي  التشغيل  وضع  بين  الانتقال  يمكن  القناع         اداة  بأستخدام 
من  اختيارها  يتم  التي  للمنطقة  خشنا  منظرا  يخلق  القناع  ايعاز  ان  القناع.  بأيعاز 
عدم  اختيار  فيها  يوجد  التي  المناطق  عدا  ما  بذاتها  الصورة  مظللفوق  قناع  فرض  خلال 
المناطق  صبغ  او  تلوين  خلال  من  اللون  ضبط  تلطيف  يمكنك   ، هنا  من  القناع.و  وجود 

تختارها. التي 

.  bit  ٨ الرمادي  تدرجات  و    bit  ٢٤ لون  بوجود  فقط  القناع  ايعاز  تفعيل  يتم  ملاحظة: 

   

او  بالصورة  المحيطة  الافقية  و  المودية  المساطر  اخفاء  و  بأظهار  المسطرة          اداة  تقوم 
العمل. مساحة  و  الصورة  حجم  الى  تشير  التي  و  العمل،  مساحة 

الموجود  المسطرة  رمز  على  النقر  خلال  من  المسطرة  بأعدادات  التحكم  يمكن   : ملاحظة 
و  السنتمتر  و  البكسل  قبيل  من  بالابعاد  التحكم  يمكن  حيث  الشاشة  يمين  اسفل  في 

الانش.
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أداة اختيار لون الخلفية و المقدمة

أداة اظهار خطوط التقطيع

أداة اظهار الصورة - الخارطة

أداة القناع

أداة المسطرة

لوحة ادارة الادوات
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تعتبر لوحة ادارة الادوات جزءا متميزا من تقنيات الفوتوامباكت ، كما سنرى لآحقا. و تتكون هذه اللوحة التي 
نستطيع نقلها و تحريكها يمينا و يسارا من الاجزاء التالية:

١ - اداة اختيار الطبقات و ادارة الطبقات: ان اداتي اختيار الطبقات و ادارة الطبقات تتموضعان في نفس 
اللوحة و تساعدان المستخدم في تنظيم الصور و الكائنات الرسومية بكل يسر و سهولة حيث ان المستخدم 

يستطيع التنقل بين كلا الاداتين بالنقر على ايقونات اداة الاختيار و الادارة.

أ - اداة ادارة الطبقات:

تستطيع ان تنفذ العمليات التالية بأداة ادارة الطبقات:
١ - بالامكان اخفاء و اظهار الصورة او الكائن الرسومي الرئيسي بالنقر على ايكون العين . 

٢ - تصنيف المصغرات ابجديا او حسب الحجم.
٣ - سهولة القام بأختيار الكائنات الرسومية بالنقر على الكائن في ادارة الطبقات.

٤ - بالامكان اجراء التعديلات التالية على الكائنات الرسومية من خلال استخدام مدير الطبقات و هذه 
التغييرات هي، سحب المصغرات لتغيير ترتيبها و امكانية تغيير اسم المصغرة و تعديل الشفافية و مستوى 

مزج الالوان.
٢ - اداة اختيار الطبقات و تكون على الشكل التالي:
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ان وظيفة لوحة ادارة الوثائق تظهر كل اوثائق المفتوحة في مساحة العمل و بالامكان الانتقال الى تنفيذ اي 

كائن رسومي او صورة فيها.بالنقر على المصغرة في لوحة ادارة الوثائق و ستظهر اللوحة النشطة.

 . 

و هذا شرح مبسط لمهام لوحة ادارة الوثائق:
١ - ايعاز الادارة السريع: و يقوم بفتح القائمة عندما تختار تطبيق المهمة الحالية في لوحة الاوامر السريعة .

٢- مدير الشارة: و يسمح بأختيار عدة صور و تطبيق نفس الايعاز على الجميع و هذا سيوفر الوقت حيث انك لن 

تضطر الى تنشيط كل صورة على حدة.

 ٣ - التصنيف : و هنا وف يمكنك تصنيف المصغرات حسب الاسم و الحجم و تاريخ الانشاء  و الابعاد و البيانات  
و الطول و العرض .

 ٤ - حجم المصغرات : حيث يمكنك تقرير اعدادات حجوم المصغرات.
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لوحة ادارة الوثائق
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يمكنك استعراض الصور الموجودة في جهازك بواسطة هذه الاداة. يتم عرض ملفات الصور على شكل مصغرات . و 
بالنقر المزدوج عليالمصغرات يتم فتح الصورة كملف جديد ليسهل التعامل معه. قم بسحب المصغرة الى مساحة 

العمل لكي يتم لصقها كملف صوري او كائن رسومي و من ثم المباشرة بالعمل.
و لنقم الان بالتعرف على مكونات ادارة استعراض الصور:

١ - الملف الشجري : يقوم بأظهار الملفات الصورية المتوفرة في الجهاز.
٢ - لوحة العرض: تقوم بعرض جميع الصور على شكل مصغرات.

٣ - لوحة EXIF : و تقوم بعرض بيانات الصورة التي تكون مرفقة معها اثر التقاطها بالكاميرا الرقمية.
٤ - بيانات EXIF :  و تقوم بعرض مربع الحوار الذي تستطيع منه معرفة مواصفات الصورة.

٥ - توسيع / اعادة خزن و استدعاء الملف الصوري: و يتم بواسطته التنقل بين ادارة المستعرض من اجل ملء مساحة 
العمل .

٦ - عودة: القيام بفتح ملفات الصور الاكثر استخداما.
٧ - تقدم: القيام بفتح الملف الصوري التالي في تسلسل ترتيب الصور قدما.

٨ - الصعود بمستوى واحد : القيام بفتح الملف الحالي .
٩ - انعاش : القيام بالتحديث على الصور  و محتويات الملف الصوري.

١٠ - البحث: اقيام بفتح مربع حوار يسمح للمستخدم بالبحث عن ملف صوري او كائن رسومي محدد.
١١ - الكاميرا الرقمية: القيام بفتح مربع حوار معامل الكاميرا الرقمية و الذي يسمح للمستخدم بأستيراد الصور 

من ذاكرة الكاميرا الرقمية الى جهاز الحاسوب.
١٢ - افتح: القيام بفتح ملفات صورية في مساحة العمل.

١٣ - طباعة: القيام بفتح مربع حوار الطباعة الذي يسمح للمستخدم بطبع الصور التي يتم اختيارها.
١٤ - الدوران الى اليسار: القيام بأدارة الصورة ٩٠ درجة الى اليسار.
١٥ - الدوران الى اليمين: القيام بأدارة الصورة ٩٠ درجة الى اليمين.

١٦ - محول الشارة: القيام بصورة اختيارية بتحويل ملفات صورية متعددة بالاستناد على الخيارات التي تم تثبيتها في 

ادارة استعراض الصور
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مربع حوار محول الشارة. 
١٧ - وضع الاعدادات و الخيارات: القيام بفتح مربع حوار تحويل الشارة من اجل اجراء التعديلات على اعدادات الصور.

١٨ - اظهار / اخفاء  الملف الشجري: الانتقال بين اظهار و اخفاء الملفات الشجرية لمستعرض الصور.
١٩ - اظهار / اخفاء EXIF  : الانتقال بين اظهار و اخفاء لوحة المستعرض.

 ٢٠ - التصنيف : القيام بفتح القائمة التي يظهر فيها ترتيب الملفات الصورية بحسب الاسم و الحجم و تاريخ 
الانشاء .

٢١ - حجوم المصغرات: عند القيام بالنقر على المصغرات الصورية ، قم بتحديد الحجم المطلوب للصورة.

التي  الرسومية  الكائنات  و  الاقنعة  و  المؤثرات  ، فهي تحتوي على  الشامل  التحكم  التي تضمها لوحة  المهام  تتعدد 
تستطيع الوصول اليها بسهولة و من ثم استخدامها في العمل الفني. ان معرض الصور و مكتبات اكائنات الرسومية 
تحتوي عددا هائلا من الفلاتر و الستايلات و الكائنات الرسومية و الاشكال و الكثير مما يمكن سحبه و افلاته في مساحة 
العمل  او استدعائها بمجرد النقر المزدوج عليها. و من الممكن ان يقوم المستخدم بترقية المؤثرات او الكائنات الرسومية 
عملية  او عقب  البرنامج  بزوال  تزول  لا  منفصلة  ملفات  الى  تصديرهم  او  الشامل  التحكم  لوحة  الى  اضافتهم  و 

الفرمتة.
و يمكن تقسيم لوحة التحكم الشامل الى اربعة اقسام و هي:

١ - المعارض.
٢ - مكتبات الكائنات الرسومية.

٣ - شريط ادوات لوحة التحكم الشامل.
٤ - قائمة اوامر الزر الايمن.

 ١ - المـعــارض
تكون المعارض في لوحة التحكم الشامل مقسمة الى عدة مجاميع و هي:

١ - الصور و مستلزماتها : كما في الصورة ادناه و تشتمل على المعارض التالية:

١ - معرض الملء: يحتوي معرض الملء على عدد كبير من حشوات التدرج اللوني و النسيج الخامات و الاشكال التي 
تستطيع استخدامها كخلفية في الصور التي تقوم بمعالجتها.

٢ - معرض مؤثرات الصور: يمنح معرض مؤثرات الصور توضيحا بصريا لما ستقوم بأختياره من مؤثرات.هناك مستعرضات 

التي  الرسومية  الكائنات  و  الاقنعة  و  المؤثرات  ، فهي تحتوي على  الشامل  التحكم  التي تضمها لوحة  المهام  تتعدد 
تستطيع الوصول اليها بسهولة و من ثم استخدامها في العمل الفني. ان معرض الصور و مكتبات اكائنات الرسومية 
تحتوي عددا هائلا من الفلاتر و الستايلات و الكائنات الرسومية و الاشكال و الكثير مما يمكن سحبه و افلاته في مساحة 
العمل  او استدعائها بمجرد النقر المزدوج عليها. و من الممكن ان يقوم المستخدم بترقية المؤثرات او الكائنات الرسومية 
عملية  او عقب  البرنامج  بزوال  تزول  لا  منفصلة  ملفات  الى  تصديرهم  او  الشامل  التحكم  لوحة  الى  اضافتهم  و 

 - معرض مؤثرات الصور: يمنح معرض مؤثرات الصور توضيحا بصريا لما ستقوم بأختياره من مؤثرات.هناك مستعرضات 
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ادارة لوحة التحكم الشامل
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متوفرة تتيح للمستخدم اختيار المؤثر الذي يريده بمجرد النقر المزدوج او السحب و الافلات.
 ٣ - معرض الستايلات : يحتوي معرض الستايلات على مصفوفات من الفلاتر وضعت اساسا من اجل تغيير تلوين 
الصورة. هذه الفلاتر تسمح للمستخدم بتطبيق درجة الصبغ او الدرجة اللونية و تغييرات الاضاءة و الاكساءات و ذلك 

بالنقر المزدوج على ايكونة المصغرات او بواسطة تقنية السحب و الافلات.
٤ - معرض المؤثرات الخاصة: ان معرض المؤثرات الخاصة يمنح امكانية بصرية في تمكين المستخدم من اختيار عدد متنوع 
و كبير من المؤثرات .و يحتوي معرض المؤثرات الخاصة على مصفوفات الاضاءة و المصفوفةالفنية و مصفوفة التشتيت 

و المؤثرات الاخرى . و بأمكانك تطبيق هذه المؤثرات على صورة او اساس عمل فني قمت بأنشائه مسبقا.
٥ - معرض الفرش: يحتوي معرض الفرش على اعدادات ذات تعريف مسبق و مبرمج من اجل التنسيق في العمل مع 
انواع عديدية من الفرش و التقنيات مثل فرش الصبغ و التلوين و تقنيات الرتوش و النسخ التي يمكنك و بكل سهولة 

استدعائها بالنقر المزدوج على المصغرة التي ترغب في تفعيلها او بأستعمال تقنية السحب و الافلات.
٦ - معرض الختم ( الطوابع) : يحتوي معرض الاختام ( الطوابع) على اختيارات واسعة من الطوابع او الرسمات التي 
من  منوعة  بحتوي على تشكيلة  . كل طابع  الفنية  اعمالك  او  فوق صورك  او طباعتها  او لصقها  يمكنك رسمها 
المواضيع او الصور او الكائنات الرسومية ( و على سبيل المثال : الفواكه الاستوائية) و التي يمكنك ان تقوم بوضعها 

يدويا فوق الصور بنقرة واحدة. 
الرسومية مثل  الكائنات  يوفر مجموعة كبيرة من عناصر  الفنية  العناصر  ان معرض  الفنية:  العناصر  - معرض   ٧
النجوم و الغيوم و المطر و الضباب و التي تستطيع ان تضيفها الى صورك . ان هذه الكائنات الرسومية و المواد قد تم 
تعزيزها و برمجتها بصورة مسبقة . و من اجل القيام بتعديل المؤثرات  يدويا ، نقوم بالنقر على الزر الايمن للماوس  على 

اي مصغر لفتح مربع حوار الخصائص و من ثم القيام بتطبيق او اختيار المؤثر :
Effect: Creative - Particle Effect. 

. و يحتوي هذا  ٨- معرض الاضاءة الفنية و الابداعية:  ان معرض الاضاءة يوفر خيارات بصرية للمشاهدة و الانتقاء 
المعرض على اشكال مختلفة من المؤثرات المبرمجة و المعدة مسبقا من اجل تسهيل استعمالها في رسوماتك. و 
الاعدادات هنا هي معدة مسبقة ايضا . و من اجل الوصول الى خواص المصغرات و المؤثرات ، نقوم بالنقر الايمن بزر الماوس 

.  properties ثم نختار خواص
الرسوم  تأثيرات  لأاعدادات  مصفوفة  مصغرات  يعرض  المتحركة  الرسوم  معرض  ان  المتحركة:  الرسوم  معرض   -  ٩

المتحركة و الاستوديو الخاص بها بالاضافة الى مؤثرات عناصر الطبيعة و عتاصر الطباعة .
١٠ - معرض الازرار : ان معرض الازرار يحتوي على مجموعة من المصفوفات للازرار التي يمكن استخدامها في تجميل 

مواقع الويب او مشاريع الفيديو او المشاريع الاخرى.
، يتحول الزر الى كائن رسومي متحد مع  ملاحظة : بعد الاتهاء من تطبيق الزر على نص او كائن رسومي او صورة 

العناصر الاخرى للتشكيل.
١١ - معرض اطارات الصور : يحتوي معرض اطارات الصور على مجموعة متنوعة من الاطارات ذات الالوان و الزوايا و 

الاشكال اتلفة . 

٢ - مؤثرات الاشكال و الخطوط

ان حاجة المصمم الى الرسوم لا تقل اهمية عن مقدار الحاجة الى النصوص و الاشكال المفرغة . وبالنظر للتوسع في 
انتاج الاعمال الفنية التي تحتاج و بدون شك الى النصوص و الاشكال المفرغة ، كان هذا الشرح المسهب عن مؤثرات 

الاشكال و الخطوط.
ان مجموعة معرض الخطوط و الاشكال توفر دعما غير محدود بالنسبة لنوعية الخامات و الاكساءات و التي يمكن عن 

طريق تغيير اعدادات مواصفاتها  تطبيقها بشكل اكثر سهولة على النصوص و الاشكال.
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و لنتعلم الان ما تعنيه تفرعات مؤثرات الاشكال و الخطوط:
١ - معرض خيارات المواد: يحتوي معرض المواد على مصفوفات تحتوي على الالوان و النسيج ( الخامات) التي تستطيع 

تطبيقها على الاشكال و الخطوط.
٢ - معرض المواد : يحتوي معرض المواد على مصفوفات اللون و الانعكاس و التجسيم و اساليب التظليل ( اضافة الظل) 

التي تستطيع تطبيقها على الخطوط و النصوص و الاشكال .
 ٣ - معرض ستايلات الخطوط: معرض ستايلات الخطوط يوفر مصفوفات مواصفات المؤثرات على الخطوط.

٤ - معرض التشويه: يوفر معرض التشويه المؤثرات التي بأمكانها ان تضفي التأثير المطلوب على العمل الفني.
٥ - معرض مؤثرات الالتفاف: يحتوي معرض كائنات الالتفاف على تشكيلة واسعة من انواع تأثيرات الالتفاف على 

الكائنات الرسومية و الاشكال و الخطوط.
٦ - معرض الطباعة: يقوم معرض الطباعة بتوفير خيارات منظورة من أجل تسهيل اختيار نوع تأثير الطباعة الموجود او 
المتوفر في قائمة الطباعة. و هذا المعرض يحتوي على مصفوفات التأثير على النص و الذي تستطيع تطبيقه بسهولة 

على كائن النص.
ملاحظة : بالامكان القيام بتطبيق تأثيرات الطباعة على كائنات الاشكال.

٣ - معرض المهام
يمكن القول ان معرض المهام يمكنه توفير خزين من المهام المسجلة التي اضيفت الى لوحة الاوامر السريعة او القياسية 
الرسومية.و هذه  الكائنات  او على  الفني  العمل  الاساسية في  الصورة  بتطبيقها على  القيام  المهام يمكن  و هذه   .

المهمة بسيطة و فاعلة مثل مهام القطع و اللصق و الاستنساخ.
  

 - معرض خيارات المواد: يحتوي معرض المواد على مصفوفات تحتوي على الالوان و النسيج ( الخامات) التي تستطيع 

 - معرض المواد : يحتوي معرض المواد على مصفوفات اللون و الانعكاس و التجسيم و اساليب التظليل ( اضافة الظل) 

 - معرض مؤثرات الالتفاف: يحتوي معرض كائنات الالتفاف على تشكيلة واسعة من انواع تأثيرات الالتفاف على 

 - معرض الطباعة: يقوم معرض الطباعة بتوفير خيارات منظورة من أجل تسهيل اختيار نوع تأثير الطباعة الموجود او 
المتوفر في قائمة الطباعة. و هذا المعرض يحتوي على مصفوفات التأثير على النص و الذي تستطيع تطبيقه بسهولة 

يمكن القول ان معرض المهام يمكنه توفير خزين من المهام المسجلة التي اضيفت الى لوحة الاوامر السريعة او القياسية 
الرسومية.و هذه  الكائنات  او على  الفني  العمل  الاساسية في  الصورة  بتطبيقها على  القيام  المهام يمكن  و هذه   .
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٤ - معرضي ( معرض المستخدم)
يمكن للمستخدم ان يقوم بخزن الصور و الاعمال الفنية التي قام بأنشائها في هذا المعرض.

مكتبات الصور و الكائنات الرسومية
١ - مكتبة الصور: تحتوي مكتبة الصور على مجموعة من الصور التي يمكنك وضعها او الاستعانة بها في اعمالك 
و الكثير من الاشياء و  العالمية و صور الطبيعة  . و تحتوي هذه اموعة على تشكيلة من النصب المعمارية  الفنية 

المواضيع اتلفة التي نستخدمها في حياتنا اليومية.

٢ - مكتبة القناع: تحتوي مكتبة القناع على مجموعة من الاقنعة التي تستطيع بواسطة السحب و الافلات او النقر 
المزدوج من احداث تأثير على الصورة او العمل الفني.الاقنعة هي عبارة عن تقنية مفيدة عندما نريد اخفاء او تظليل 
من  متباينة  درجات  مع  الرمادية  الضلال  من  اتلفة  الدرجات  شفافية.ان  اكثر  جعلها  او  الصورة  من  الاجزاء  بعض 

الشفافية على مستويات القناع تزيد بدرجة او بأخرى من جمالية و حرفية العمل الفني.
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٣ - مكتبة الاشكال: تحتوي مكتبة الاشكال على مجموعة متنوعة من الاشكال المصمتة التي تستطيع بطريقة 
السحب و الافلات من وضعها في صورك. و من الممكن تحويل هذه الاشكال من ثنائية الابعاد الى ثلاثية الابعاد بالتحويل 

او الانتقال من خلال اختيار وضع التجسيم في شريط الادوات.

٤ - مكتبة الخطوط ( الباترون): ان مكتبة الخطوط او الاشكال المفرغة تحتوي على مجموعة من الاشكال المتكونة من 
خطوط متصلة بدون فراغات. و بواسطة هذه التشكيلة يمكنك ترقية العمل الفني و ذلك عن طريق السحب و الافلات 

او القيام بعملية النقر المزدوج على الشكل.

٥ - مكتبة الخطوط:تحتوي مكتبة الخطوط على مجموعة من الكائنات الرسومية الخطية ثلاثية الابعاد و التي تستطيع 

اضافتها الى العمل الفني. 

 - مكتبة الاشكال: تحتوي مكتبة الاشكال على مجموعة متنوعة من الاشكال المصمتة التي تستطيع بطريقة 
السحب و الافلات من وضعها في صورك. و من الممكن تحويل هذه الاشكال من ثنائية الابعاد الى ثلاثية الابعاد بالتحويل 

 - مكتبة الخطوط ( الباترون): ان مكتبة الخطوط او الاشكال المفرغة تحتوي على مجموعة من الاشكال المتكونة من 
خطوط متصلة بدون فراغات. و بواسطة هذه التشكيلة يمكنك ترقية العمل الفني و ذلك عن طريق السحب و الافلات 

 - مكتبة الخطوط:تحتوي مكتبة الخطوط على مجموعة من الكائنات الرسومية الخطية ثلاثية الابعاد و التي تستطيع 
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٦ - مكتبة المسارات : تحتوي مكتبة المسارات على مجموعة من الكائنات الرسومية المعدلة على اساس المسارات و 
التي يمكنك بواسطة السحب و الافلات او النقر المزدوج من اضافتها الى العمل الفني الخاص بك.و عادة ما توجد هذه 
المسارات الكائنية بشكل رزمة group  يمكنك ان تقوم بتفكيكها و اعادة تشكيلها مرة اخرى ، او تعديلها بأستخدام 

اداة تعديل المسارات.

٧ - مكتبة القوالب الجاهزة: تحتوي مكتبة القوالب الجاهزة على مجموعة من التصاميم لقوالب مواقع الويب و بطاقات 
و هكذا  القوالب  الضرورية موجودة نصيا على هذه  القوالب.المعلومات  و غيرها من  الدعوة  و بطاقات  الاعمال  رجال 

يمكنك ترقية المحتوى الى شيء اكثر ملائمة لأستعمالك الشخصي . 
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٨ - مكتبتي ( المكتبة الشخصية للمستخدم) : و هذه المكتبة تكون خاصة للاحتفاظ بالابداعات الشخصية 

التي يقوم المستخدم بتطويرها في البرنامج.

شريط ادوات لوحة التحكم الشامل

١ - قائمة المعارض.

 - مكتبتي ( المكتبة الشخصية للمستخدم) : و هذه المكتبة تكون خاصة للاحتفاظ بالابداعات الشخصية 
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٢ - قائمة مكتبات الكائنات الرسومية.

٣ - اخفاء / اظهار الملف الشجري.
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٤ - استخدام صورة ، القيام بأختيار منطقة ، او كائن رسومي كمصغر: 
يسمح لك هذا الخيار بالتثبت من ان صورك سوف تظهر بمؤثرات متنوعة و ذلك عن طريق استبدالها  بالصور 

الفاعلة حاليا . 
٥ - قائمة اوامر معارض المصغرات.

ملاحظة : يمكن في هذه القائمة تعديل فلاتر الفوتوشوب و اضافتها الى برمجة الفوتوامباكت.
٦ - ترقية / تعديل لوحة التحكم الشامل.

٧ - ايجاد / بحث.
٨ - حجم المصغرات.

لوحة الالوان
 تتوسط لوحة الالوان لوحة ادارة الادوات و هي تقوم او تختص بتنظيم سهولة استخدام الالوان لكل الادوات 
اداء ادوات اخرى مثل مصغرات اللون المتدرج و  في برنامج الفوتوامباكت.و هذه الاداة تتيح لك الاختيار  لتعزيز 
الاعتيادي للصبغ و التلوين و الرتوش و التأثير على النصوص و الاشكال المفرغة و المصمتة ...الخ.و بالامكان ان 

تقوم انت بأضافة الوانك الخاصة الى لوحة ادارة الالوان . و لا يتطلب الامر سوى الايعاز ادناه:
  Workspace> Panels > Color Panel or click Color Panel  

 و يمكن اجمال ما تقوم به لوحة الالوان على النحو التالي:

١ - الملء بلون واحد:

يسمح لك هذا الخيار بالتثبت من ان صورك سوف تظهر بمؤثرات متنوعة و ذلك عن طريق استبدالها  بالصور 

 تتوسط لوحة الالوان لوحة ادارة الادوات و هي تقوم او تختص بتنظيم سهولة استخدام الالوان لكل الادوات 
اداء ادوات اخرى مثل مصغرات اللون المتدرج و  في برنامج الفوتوامباكت.و هذه الاداة تتيح لك الاختيار  لتعزيز 
الاعتيادي للصبغ و التلوين و الرتوش و التأثير على النصوص و الاشكال المفرغة و المصمتة ...الخ.و بالامكان ان 
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يقوم هذا الاختيار بالملء بأستخدام لون واحد و على النحو التالي:
١ - الكيفية : انقرعلى الزر المثلث من أجل التمكن من اختيار وضعية الملء.

٢ - اضافة لون : انقر على السهم من اجل فتح قائمة النافذة الاعلانية ، ثم انقر على اختيار لون واحد او لونين 
او ثلاثة الوان. 

٣ - تحويل اللون اتار من الاسود الى الابيض و بالعكس:و ينشط هذا الخيار فقط في حالة اللون الواحد. 
٤ - التحذير الخاص بالوان الويب: ينشط فقط في حالة وضعية اختيار الوان موقع الويب .

٥ - قسم اختيار الصبغة: انقر على المثلث من اجل اختيار عدد من الالوان .
٦ - نظام الوان RGB  و HSB : و يقوم هذا الاختيار بالتحكم بنظام اظهار الالوان الذي تريده.

٧ - القيمة الرقمية للالالوان التي تريد اختيارها.
٨ - الطيف مقياس المطيافية: و يقوم بأظهار مقياس المطيافية بما في ذلك تدرجات اللون الرصاصي و الاسود.

التدرج الناشيء عن  ٢ - اختيار الملء بلونين:و يقوم هذا اخيار بالعمل على التحكم في 
اختيار لونين و على النحو التالي:

١ - اللون الاول : و يقوم بأظهار اللون الاول من لوني الملء. قم بالنقر على اللون الذي تريد استخدامه ، 
٢ - استبدال لون مكان آخر: العمل على استبدال اللونين الذين تم اختيارهما الواحد بدلا من الاخر.

 ٣ - اللون الثاني: و يقوم هذا الخيار بأظهار اللون الثاتي في لوني الملء الذين قمت بأختيارهما .

 ٤ - المرتبة اللونية: و يحدد هذا الخار المرتبة اللونية لأي لون تقوم بأختياره.  

٣ - الملء بألوان متعددة:
من الممكن ايضا الملء بأكثر من لونين بهذا الايعاز.و من اجل القيام بأضافة لون ، ننقر على عمود المطيافية و 

نختار اللون من اداة التقاط اللون. لا بد ايضا من ترتيب اعدادات الصبغة اللونية .
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لوحة التقاط اللون

يقوم هذا الايعاز بأظهار لوحة اختيار او التقاط الالوان لأستخدامها فيما بعد في تحرير الصور و اللوحات.و عندما 
تقوم بتحريك الماوس فوق مربعات الالوان ، يتحول شكل الماوس الى اداة قطارة و تظهر آليا قيم RGB  و HSB  .انقر 
على اية خلية و قم بأختيار اللون الذي تريده. و سوف يتم الاحتفاظ بهذا اللون عندما تنتقل الى مساحة العمل 

في البرنامج. 

لوحة اختيار التدرجات اللونية
. RGB تظهر لنا هذه اللوحة تدرجات لونية جاهزة بأكثر من لون و لكنها تنشط فقط في

يقوم هذا الايعاز بأظهار لوحة اختيار او التقاط الالوان لأستخدامها فيما بعد في تحرير الصور و اللوحات.و عندما 
  .انقر 
على اية خلية و قم بأختيار اللون الذي تريده. و سوف يتم الاحتفاظ بهذا اللون عندما تنتقل الى مساحة العمل 
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يوفر لنا برنامج الفوتوامباكت عدداهائلا من المؤثرات التي تساهم بشكل فاعل في تحسين نمط الاخراج النهائي 
للصور، شأنه في ذلك شأن البرامج الصورية .ان بأمكانك ان تقوم بأضافة الخامات ( النسيج) المشتقة من الخامات 
الطبيعية و الصناعية ، و ايضا تغيير المظهر الخارجي للصورة و القيام بتطبيقات الاضاءة .ان لعض المؤثرات ايضا 

.GIF متحركة و التي يمكن خزنها في المكتبة الصورية بصيغة  GIF قادرة على تحويل الصورة الساكنة الى صور
الاقسام الرئيسية للمؤثرات تقسم الى :

١ - الاضاءة .
٢ - المؤثرات الفنية.

٣ - التشويه.
٤ - الملء بالنسيج و الخامات.

٥ - المؤثرات الابداعية.
٦- مؤثرات الفيديو.

 مؤثرات الاضاءة
خاصة  مؤثرات  خلق  بالامكان  و  الصورة  على  لوني  تباين  اضفاء  اجل  من  الاضاءة  مؤثرات  استخدام   بالامكان 

تضفي المزيد من المعاني و الحرفية على الصورة مثل الاشعة و الالعاب النارية.
 تقسم الاضاءة الى الاقسام التالية:

١- الصورة ذات الانطباع البارد Cool : حيث تضاف قيمة لونية الى الصورة او يتم معالجتها لتخفيف الالوان 
الحارة فيها.

٢ - الصورة ذات الانطباع الدافيء او الحارWarm : حيث يتم معالجة الصورة لأضافة شيء من الدفء او لتعديل 
الالوان الباردة فيها.
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٣ - creative lighting  الاضاءة الفاعلة : و قبل ان ندخل في مجاهل هذا القسم لا بد من ملاحظة هذه المسألة.   
اذا كنت تريد التحكم الكامل بالمؤثر creating effect  فينبغي اولا الذهاب الى قائمة effect  و من ثم النقر حيث 

سيظهر لنا مربع الحوار التالي:

و كما هو واضح ، فأن لكل شعبة من شعب المؤثرات مربع حوار خاص في التعامل معها.
 و يحتوي هذا القسم على :

١ - تأثير البرق: بأمكان هذا المؤثر ان يضيف تأثير البرق على الصورة التي تتعامل معها .

  الاضاءة الفاعلة : و قبل ان ندخل في مجاهل هذا القسم لا بد من ملاحظة هذه المسألة.   
  و من ثم النقر حيث 
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١٠
ت 

باك
ام

تو
فو

 ال
ف

تر
اح

 و 
لم

تع

٢ - تأثير الالعاب النارية: بأمكان هذا المؤثر ان يضيف تأثير الالعاب النارية و بأشكال مختلفة على الصورة.

٣ - تأثير الاشعة الضوئية: و يقوم هذا المؤثر بأضفاء بقعة اشعة تزيد من واقعية الصورة او العمل الفني:

٤ - تأثير ضوء المصباح : و من شأن هذا التأثير ان يحول البقعة الكامدة الى بقعة تحتوي على مقدار نسبي و جيد 
من الاضاءة.
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٥ - تأثير الهالة: و من شأن هذا التأثير ان يقوم بأضفاء الهالة على الجسم المضيء.

٦ - بقعة الضوء: و من شأن هذا التأثير انه يقوم بأضافة بقعة ضوء الى منطقة مقصودة في العمل الفني.

اليه  اتجهت  قد  الوميض  بقعة من  و كأن  يبدو  الصورة  ان يجعل جزءا من  المؤثر  الوميض:بأمكان هذا  تأثير   -  ٧
مباشرة.

 

اليه  اتجهت  قد  الوميض  بقعة من  و كأن  يبدو  الصورة  ان يجعل جزءا من  المؤثر  الوميض:بأمكان هذا  تأثير   -  
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٨ - تأثير المذنبات: يقوم هذا المؤثر بأضافة مؤثر شبيه بالمذنبات الى الصورة.

٩ - تأثير المذنب المزدوج: يقوم هذا التأثير بأضافة مؤثر شبيه بمذنب مزدوج الى الصورة.

١٠ - تأثير اضواء الليزر: يقوم هذا المؤثر بأضافة مؤثر شبيه بأضواء الليزر الى الصورة.
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المؤثرات الفنية
تستخدم المؤثرات الفنية من اجل محاكاة انواع مؤثرات الاتجاهات الفنية و التقنيات المستخدمة فيها ، مثل 
تقنيات الرسم بالالوان المائية و الرسم الزيتي و الرسم بالفحم و اقلام التخطيط و الكرافيت . و هذا ما يجعل 

الصور تبدو و كأن رساما محترفا قد قام برسمها.
تشتمل المؤثرات الفنية على :

١ - تأثير الرسم بالالوان المائية:من شأن هذا المؤثر ان يجعل الصور الحقيقية تبدو و كأنها منفذة بطريقة الالوان 
المائية.

تستخدم المؤثرات الفنية من اجل محاكاة انواع مؤثرات الاتجاهات الفنية و التقنيات المستخدمة فيها ، مثل 
تقنيات الرسم بالالوان المائية و الرسم الزيتي و الرسم بالفحم و اقلام التخطيط و الكرافيت . و هذا ما يجعل 

 - تأثير الرسم بالالوان المائية:من شأن هذا المؤثر ان يجعل الصور الحقيقية تبدو و كأنها منفذة بطريقة الالوان 
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الممكن استخدامها في  فنية من  المؤثر لمسة  الهندسية: يضفي هذا  الاشكال  و  بالمربعات  التقطيع  تأثير   -  ٢

تقطيع الصورة الى شكل شبيه بالفسيفساء مع امكانيات عديدة لتصيير الصورة .

٣ - تأثير افلام الرسوم المتحركة: يقوم هذا المؤثر بأضفاء لمسة تشبه تأثير الرسوم المتحركة على الصور.

٤ - تأثير اقلام الشحم: يقوم هذا المؤثر بأضفاء تأثير اقلام التلوين على الصور.
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٥ - تأثير اقلام التلوين:يقوم هذا المؤثر بتنعيم الصورة و جعلها مشابهة للصور المنفذة بأقلام التلوين.

- تثير رسم اططات : يقوم هذا المؤثر بتحويل الصورة الى عمل مشابه للتخطيطات الاولية التي يستند   ٦

عليها الرسامون في اكمال العمل الفني.

٧ - تأثير الديكوبايج ( الورنيش): يقوم هذا المؤثر بأضفاء لمسة مشابهة لطلاء الورنيش الذي يقوم بأضفاء تشويه 
متعمد و مدروس لخدمة العمل الفني.

- تثير رسم اططات : يقوم هذا المؤثر بتحويل الصورة الى عمل مشابه للتخطيطات الاولية التي يستند   

 - تأثير الديكوبايج ( الورنيش): يقوم هذا المؤثر بأضفاء لمسة مشابهة لطلاء الورنيش الذي يقوم بأضفاء تشويه 
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٨ - تأثير الطبع على سطح معدني: نتذكر جميعا عندما كنا اطفالا و كانت النقود المعدنية جزءا من التداول 
اليومي في اقتصاد العراق ، كيف كنا نضع العملة المعدنية تحت ورقة ثم نقوم بحك الورقة بقلم الرصاص ، ليترك 

فيما بعد اثرا شبيها بالنقش الموجود على القطعة المعدنية . هذا المؤثر يؤدي نفس الغرض.

يطبع  التي  الحريرية  السكرين  شاشة  به  تقوم  الذي  الدور  نفس  المؤثر  هذا  يؤدي  السكرين:  شاشة  مؤثر   -  ٩
بواسطتها القماش و المعادن و الجلود و المواد الصناعية. و تتم بواسطة تطبيق صورة على سطح معدني ذو نقوش 

او فراغات ثم تغمر بالصبغ او الحبر . 

١٠ - رسم الاصابع : هذا المؤثر يشبه كثيرا عملية الرسم بالاصابع بدلا من الفرشاة ، و هو لا يخلو من الجمالية 

على اية حال.
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١١ - الرسم النقطي : في بعض الاحيان نشاهد لوحات فنية تم رسمها بواسطة نقاط كثيرة متباينة في الحجم 
و اللون و التوزيع و الكثافة . هذا المؤثر يؤدي نفس الغرض.

١٢ - مؤثر الفن الانطباعي: بدأ الاتجاه الانطباعي في اوروبا في القرن التاسع عشر كحركة فن حديثة تبنت بعدا 
منظوريا جديدا للرسم و تتميز تقنية الرسم بخفة و رشاقة الفرشاة التي تفي للضوء و الموضوع حقهما . هذا 

المؤثر يستطيع ان يجعل من صورك فنا انطباعيا.

و  البحر الابيض المتوسط  التي ظهرت في حضارات  القديمة  الفنون  الموزائيك: يعتبر فن اموزائيك من  -تأثير   ١٣
يستند اساسا الى الصاق و ترتيب قطع الموزائيك الصغيرة بترتيب معين من اللون و الخطوط لكي تنتج شكلا او 

موضوعا معينا. هذا المؤثر يساعد في اضفاء تأثير الموزائيك على صورك.

 - الرسم النقطي : في بعض الاحيان نشاهد لوحات فنية تم رسمها بواسطة نقاط كثيرة متباينة في الحجم 

 - مؤثر الفن الانطباعي: بدأ الاتجاه الانطباعي في اوروبا في القرن التاسع عشر كحركة فن حديثة تبنت بعدا 
منظوريا جديدا للرسم و تتميز تقنية الرسم بخفة و رشاقة الفرشاة التي تفي للضوء و الموضوع حقهما . هذا 

البحر الابيض المتوسط و  التي ظهرت في حضارات  القديمة  الفنون  الموزائيك: يعتبر فن اموزائيك من  -تأثير   
يستند اساسا الى الصاق و ترتيب قطع الموزائيك الصغيرة بترتيب معين من اللون و الخطوط لكي تنتج شكلا او 
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١٤ - تأثير الرسم بألوان الزيت: ان الرسم بالالوان الزيتية هو تقنية تعود الى القرون الوسطى. و تطورت بدرجة 
مذهلة على يد فناني و رسامي عصر النهضة . و بالرغم من وجود عدة مدارس و اتجاهات في موضوعة الرسم 
بالالوان الزيتية ، فأن تأثير اللون الزيتي على القماش يعطي تأثيرا جميلا جدا.هذا المؤثر يحول صورك الى رسوم 

بالالوان الزيتية.

١٥ - تأثير القلم و الحبر: يعتبر استخدام اقلم و الحبر اسلوبا اصيلا في رسم الاعمال الفنية و بالذات في مجال 
البورتريه كما انه يتميز بالعمق و القوة . من الممكن ان يقوم هذا المؤثر بتحويل رسومك الى صور مرسومة بالقلم 

و الحبر.

١٦ - تأثير الشاشة ( الاعلان): يقوم هذا المؤثر بجعل الصور تبدو و كأنها قد رسمت على القماش الجنفاص ( قماش 
الرسم ).
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١٧ - تأثير التغشية : يقوم هذا المؤثر بوضعنوع من التغشية على الصور .

١٨ - تأثير التنقيط المظلل: يتميز هذا التأثير بالنقاط التي يكون معها ظل و التي تؤلف بمجموعها تركيبافنيا 

يكون مناسبا مع العمل الذي يتم اختياره بعناية.

١٩ - تأثير التموج: يضفي هذا المؤثر نوعا من التموج على العمل الفني.

١٠ - تأثير التنقيط المظلل: يتميز هذا التأثير بالنقاط التي يكون معها ظل و التي تؤلف بمجموعها تركيبافنيا 
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مؤثرات التشويه
١ - تأثير التربيع: يقوم هذا المؤثر بجعل الصورة تبدو و كأنها محجوزة او مغطاة بلوح زجاجي.

٢ - تأثير القرصة: تبدو الصور المعالجة بهذا المؤثر و كأنها مسحوبة الى الداخل.

٣ - تأثير السحب: يؤدي هذا المؤثر الى نفخ الجزء الذي يخضع لتفعيله.

١٠
ت 

باك
ام

تو
فو

 ال
ف

تر
اح

 و 
لم

تع



65

٤ - تأثير التموج: يؤدي هذا المؤثر الى التسبب في تموج في مظهر الصورة بحيث تظهر و كأنها تموجات سطح 

الماء.

٥ - مؤثر التكوير: يؤدي هذا المؤثر الى تحويل المشهد الى شيء اشبه بالتجسيم الكروي او الدائري و كأنه ملفوف 

على كرة.

٦ - مؤثر التسمين: يؤدي هذا المؤثر الى تمطية مركز الصورة نحو حواف اليمين و اليسار و تقليص حجم الاجزاء 
الخارجية للجزء المشمول بالتفعيل.

 - تأثير التموج: يؤدي هذا المؤثر الى التسبب في تموج في مظهر الصورة بحيث تظهر و كأنها تموجات سطح 

 - مؤثر التكوير: يؤدي هذا المؤثر الى تحويل المشهد الى شيء اشبه بالتجسيم الكروي او الدائري و كأنه ملفوف 

 - مؤثر التسمين: يؤدي هذا المؤثر الى تمطية مركز الصورة نحو حواف اليمين و اليسار و تقليص حجم الاجزاء 
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٦ - مؤثر التنحيف: على العكس من المؤثر السابق الذكر اعلاه ، يقوم هذا المؤثر بتمطية حواف اليمين و اليسار 
في الصورة نحو الوسط و يقلص المساحة الداخلية المشمولة بالتفعيل.

٧ - اللف بأستخدام الشبكة: يسمج لك هذا المؤثر بالقيام بلف بعض الاجزاء من الصورة بالاستعانة بشبكة 

تتحكم فيها بالاجزاء التي تريد احداث التغيير عليها.
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٨ - مؤثر الدوامة: يسمح لك هذا المؤثر بأحداث تأثير شبيه بالدوامة من المركز الى الاطراف في الصورة.

٩ - تأثير الهبوب: يخلق هذا المؤثر شيئا شبيها بهبوب الرياح ، و لكن اثر الهبوب لا يتلاشى و انما يتم الاحتفاظ 
به في الصورة.

يزول  كأنه  و  يظهر  الرياح  تأثير  لكن  و  الرياح  بهبوب  شبيها  اثرا  او  شيئا  المؤثر  هذا  يخلق   : الرياح  تأثير   -  ١٠

تدريجيا.

 - تأثير الهبوب: يخلق هذا المؤثر شيئا شبيها بهبوب الرياح ، و لكن اثر الهبوب لا يتلاشى و انما يتم الاحتفاظ 

يزول  كأنه  و  يظهر  الرياح  تأثير  لكن  و  الرياح  بهبوب  شبيها  اثرا  او  شيئا  المؤثر  هذا  يخلق   : الرياح  تأثير   -  
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١١ - تأثير الترنح: يقوم هذا التأثير بأحداث تشويه افقي و عمودي حيث يغير اماكن تموضع البيكسلات الى اليمين 
او اليسار ، مما يخلق تأثيرا يشبه رؤية شيء خلال موجات حرارة مرتفعة.

١٢ - التحويل الابداعي : يخلق هذا المؤثرحركة شبيه بالانتقالة لجزء معين من الصورة و يمكن الاحتفاظ بالملف 
.GIF الناتج بصيغة

١٣ - الالتفاف الابداعي: يقوم هذا المؤثر بالعمل على تشظية الصورة مع الاحتفاظ بالاصل .
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مؤثرات البلورة و الزجاج
١ - تأثير الكرة: يقوم هذا المؤثر بفرض او تغطية الجزء اتار من الصورة بشكل كرة من البلور.

٢ - تأثير المعين: يقوم هذا المؤثر بفرض او تغطية الجزء اتار من الصورة بشكل معين من البلور.

٣ - تأثير المكعب: يقوم هذا المؤثر بفرض او تغطية الجزء اتار من الصورة بشكل مكعب من البلور.
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تأثير المعين: يقوم هذا المؤثر بفرض او تغطية الجزء اتار من الصورة بشكل معين من البلور.



70

٤ - تأثير الكعكة: يقوم هذا المؤثر بفرض او تغطية الجزء اتار من الصورة بشكل كعكة من البلور.

٥ - تأثير الماسة: يقوم هذا المؤثر بفرض او تغطية الجزء اتار من الصورة بشكل ماسة من البلور.

٦ - تأثير النجمة: يقوم هذا المؤثر بفرض او تغطية الجزء اتار من الصورة بشكل نجمة من البلور.
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او تغطية الجزء اتار من الصورة بشكل كرة ذات اوجه من  تأثير الكرة ذات الاوجه: يقوم هذا المؤثر بفرض   - ٧
البلور.

( دمعة) من  او تغطية الجزء اتار من الصورة بشكل قطرة  المؤثر بفرض  الدمعة): يقوم هذا  القطرة(  تأثير   -  ٨

البلور.

٩ - تأثير المزهرية: يقوم هذا المؤثر بفرض او تغطية الجزء اتار من الصورة بشكل مزهرية من البلور.

او تغطية الجزء اتار من الصورة بشكل كرة ذات اوجه من  تأثير الكرة ذات الاوجه: يقوم هذا المؤثر بفرض 

( دمعة) من  او تغطية الجزء اتار من الصورة بشكل قطرة  المؤثر بفرض  الدمعة): يقوم هذا  القطرة(  تأثير 
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١٠ - تأثير الكأس:يقوم هذا المؤثر بفرض او تغطية الجزء اتار من الصورة بشكل كأس من البلور.

تأثير الامالة
رغم ان هذا المؤثر محسوب على خانة المؤثرات الخاصة بالتشويه الا ان استعماله بشكل مدروس يؤدي الى انتاج 

عمل فني متميز و يعتمد هذا طبعا على حسن الاختيار من قبل المصمم . 
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تأثيرات الملء و الخامات ( النسيج)

تحتوي خانة الملء و الخامات على تقنيات الملء التي تضيف نوعا من الحرفية الى العمل الفني و بمعنى آخر التشققات 
و التجاعيد و الحدود الطبيعية التي تتوفر في اغلب الخامات الموجودة في الطبيعة.و يحتوي هذا القسم على : 

١ - الملء بخامة الزجاج النصف شفاف:

٢ - الملء بخامة الحبيبات:

٣ - الملء بخامة الجلد المتشقق:

تحتوي خانة الملء و الخامات على تقنيات الملء التي تضيف نوعا من الحرفية الى العمل الفني و بمعنى آخر التشققات 
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٤ - الملء بخامة الجلد الصقيل:

٥ - الملء بخامة المعدن:

٦ - الملء بخامة الورق اعد ( الدعك):
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٧ - الملء بخامة البلاستيك:

٨ - الملء بخامة الصخور :

٩ - الملء بخامة الخطوط الحلقية:
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١٠ - التجسيم:تظهر الصورة المعالجة بهذا المؤثر و كأنها بارزة او ذات هيئة مشابهة للختم.

١١ - مؤثر الاحجية: تظهر الصورة في هذا المؤثر بشكل احجية  تنتظر تجميع اجزائها مجددا.

١٢ - مؤثر الرقائق:يقوم هذا المؤثر بتقطيع الصورة الى مربعات رقائق و بأمكانك اتيار كيفية فصل المربعات .
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١٣ - الملء بالناظور الرباعي:من الممكن ان تقوم بأنشاء لوحة كاملة بتكرير النقشات في هذا المؤثر.

١٤ - الملء بالتدرج السحري : بالامكان توليد تدرجات و لأكثر من لون واحد بواسطة هذا المؤثر.

١٥ - الملء بأستخدام تعميم النموذج: من الممكن صنع خلفية كاملة بواسطة هذا المؤثر عن طريق تكرار و اعادة 
ترتيب الشكل الرسومي.

 - الملء بأستخدام تعميم النموذج: من الممكن صنع خلفية كاملة بواسطة هذا المؤثر عن طريق تكرار و اعادة 
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١٦ - تأثير قلب الورقة:يعطي هذا المؤثر حركة جميلة عن طريق التحكم بأتجاه ثني الورقة و يشمل ذلك الزوايا 
الاربعة للصورة.

تأثيرات عناصر الطبيعة
في برنامج الفوتوامباكت يمكن الاستفادة من تقليدعناصر الطبيعة اتلفة مثل الامطار و الثلوج و الفقاقيع 
و النار و النجوم في تجمل الصور او اضافة عناصر فنية احترافية للصورة. و فيما يلي عناصر الطبيعة المذكورة 

اعلاه حسب ورودها في البرنامج:
١ - الفقاقيع: يمكن بواسطة هذه التقنية اضافة الفقاقيع بشكل فني للصورة المناسبة.

٢ - الشرار المتطاير:  يمكن بواسطة هذه التقنية اضافة الشرار المتطاير بشكل فني للصورة المناسبة.
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٣ - المطر: يمكن بواسطة هذه التقنية اضافة المطر بشكل فني للصورة المناسبة.

٤ - الثلج: يمكن بواسطة هذه التقنية اضافة الثلج بشكل فني للصورة المناسبة.

٥ - الغيوم: يمكن بواسطة هذه التقنية اضافة الغيوم بشكل فني للصورة المناسبة.
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٦ - الدخان: يمكن بواسطة هذه التقنية اضافة الدخان بشكل فني للصورة المناسبة.

٧ - الحريق: يمكن بواسطة هذه التقنية اضافة الحريق بشكل فني للصورة المناسبة.

٨ - النجوم: يمكن بواسطة هذه التقنية اضافة النجوم بشكل فني للصورة المناسبة.
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٩ - قلب الصورة ظاهرا و باطنا: يمكن بواسطة هذه التقنية قلب الصورة و التأثير عليها ظاهرا و باطنا.

تأثيرات الكتابة
آثرنا ان  نظرا لأهمية تأثيرات الكتابة التي يمكن بواسطتها اضافة الكثير من الحرفية على العمل الفني فقد 
يخصص لها فصل مستقل في هذا المنهج.و من الممكن و بكل سهولة ان يتم تطبيق تأثير المواد materials  و 
المؤثرات الطبيعية مثل الثلج و النار و المعادن مع امكانية التفريغ و التجسيم على الكتابة و النص الي تقوم 

بكتابته و يشمل هذا التأثيرايضا الكائنات التي نستحدثها بأدوات رسم المسارات.
تشمل مؤثرات الكتابة ما يلي:

 ١ - تأثير التدرج اللوني: حيث يقوم هذا المؤثر بتطبيق التدرج اللوني على النص او الكائن الرسومي.

٢ - تأثير الثقوب: و يقوم هذا المؤثر بتطبيق تأثير شبيه بالثقوب في داخل حدود الشكل او على النص.

آثرنا ان  نظرا لأهمية تأثيرات الكتابة التي يمكن بواسطتها اضافة الكثير من الحرفية على العمل الفني فقد 
  و 
المؤثرات الطبيعية مثل الثلج و النار و المعادن مع امكانية التفريغ و التجسيم على الكتابة و النص الي تقوم 
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تأثيرات الكتابةتأثيرات الكتابة
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٣ - تأثير حافات الزجاج: و يقوم هذا المؤثر بأحداث اثر شبيه بالحواف الزجاجية على حافات النص او الشكل او 
الكائن الرسومي.

٤ - تأثير حافات المعدن: و يقوم هذا المؤثر بأحداث اثر شبيه بالحواف المنية على حافات النص او الشكل او الكائن 
الرسومي.

٥ - تأثير التجسيم : و يقوم هذا التأثير بأحداث ما يشبه التجسيم البارز للنص او الكائن الرسومي.

٦ - تأثير التجسيم المحدد الحافة : و يقوم هذا التأثير بأحداث تجسيم ذو حواف محددة و بارزة.

٧ - تأثير النسيج البارز: و يقوم هذا المؤثر بملء الفراغ الداخلي للنص او الكائن الرسومي بما يشبه النسيج البارز 
ذو النقاط او المربعات.

٨ - تأثير التحديد البارز: يقوم هذا المؤثر باضافة تحديد بارز الى حافات الشكل او النص مع اضافة نوع حرفي و 
فني من التدرج.
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٩ - تأثير الحشو بالرمل: يقوم هذا المؤثر بملء الفراغ الداخلي بما يشبه الرمل.

١٠ - تأثير الاضاءة : و يقوم هذا المؤثر بأضافة نوع من الالتماعات على النص او الكائن الرسومي.

١١ - تأثير النار:يقوم هذا المؤثر بأضافة تأثير مشابه للنار على حواف الشكل او النص.

١٢ - تأثير الجليد : يقوم هذا التأثير بأضافة تأثير مشابه للنار على حواف الشكل او النص.

١٣ - تأثير النيون : يقوم هذا التأثير بأضافة تأثير مشابه للنيون على حواف الشكل او النص.

١٤ - تأثير الختم : يؤدي هذا المؤثر الى احداث اثر شبيه باثر الختم على الورقة او المستند.

١٥ - تأثير الطباعة البارزة: و يؤدي هذا المؤثر الى احداث اثر شبيه بالطباعة البارزة على الورق.
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١٦ - تأثير البروز المنعكس: يؤدي هذا التأثير الى ان يكون البروز في الحافة الخارجية فقط.

١٧ - تأثير الحفر البارز: يؤدي هذا المؤثر الى احداث تأثير يشبه الحفر البارز على النص.

١٨ - تأثير الحد الخارجي: يؤدي هذا التأثير الى احداث حد خارجي يحيط بالنص او الشكل المرسوم بالمسار الحر.

١٩ - تأثير مضاعفة النص: يؤدي هذا التأثير الى مضاعفة النص او الشكل المرسوم بالمسار الحر.

٢٠ - تأثير الاضاءة المتدرجة: يؤدي هذا المؤثر الى احداث اضاءة متدرجة في النص او الشكل المرسوم بأداة الرسم 
الحر.
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File menu   قائمة ملف

Ctrl + N فتح ملف جديد 
Shift + A صنع صفحة ويب جديدة

Ctrl + O فتح الملف حيث تم حفظ ملف الصورة للمرة الاخيرة
Shift + O فتح المستعرض الخاص بالصور

Ctrl + W .القيام بأغلاق ملف الصورة الحالية  
Ctrl + S القيام بحفظ ملف الصورة الحالية

القيام بحفظ الصورة الحالية بأسم مختلف او فورمات او ملف مختلف   Ctrl + Shift + S
Ctrl + Alt + S .( القيام بحفظ الصورة الحالية بشكل ملف( هتمل

Ctrl + Alt + (0~9) .القيام بأستعراض الصورة الحالية في مستعرض الويب 
Ctrl + F8 القيام بفتح او تشغيل الكاميرا الرقمية 

Ctrl + Shift+E القيام بفتح مربع حوار ملتقط الصورة
Ctrl + Shift+C البدء بوضعية الالتقاط

F11 القيام بالتقاط صورة يتم اختيارها  
Ctrl + Alt + P  القيام بفتح نافذة معاينة الطباعة

Ctrl + P القيام بطباعة ملف الصورة الحالية
نفس  في  متعددة  صور  بطباعة  او  واحدة  صورة  من  متعددة  نسخ  بطباعة  القيام    Ctrl + Shift + P

الصفحة
Alt + Enter  القيام بفتح مربع حوار مواصفات الصورة

F6 القيام بأظهار مربع حوار التفضيلات
Ctrl + Q القيام بأغلاق برنامج الفوتوامباكت 

Edit menu    قائمة التحرير
Ctrl + Z  القيام بالغاء تنفيذ الايعازات الاخيرة 

Ctrl + Y القيام بتنفيذ آخر ايعاز
Ctrl + X القيام بقص الاختيار الحالي

Ctrl + C القيام بطباعة البيانات الى الكليببورد
Ctrl + V القيام بلصق البيانات الى الكليببورد .

.القيام بلصق بيانات الصور من الكليببورد كصور جديدة في نافذة جديدة منفصلة .    Ctrl + Shift + V
Del 1 - القيام بالغاء الاختيار الحالي و تعبئة الفراغات بلون الخلفية المطلوبة .

2  – القيام بالغاء العنصر المفعل او النشط.
Ctrl + D القيام بمضاعفة الصورة الاساسية او أي عنصر و خلق ملف صورة جديد

Ctrl + R القيام بتحجيم الصورة الى الاختيار المطلوب
التدرج  او  اللون المطلوب  بأختيار ملء  القيام  التعبئة حيث يمكنك  Ctrl + F  القيام بفتح حوار صندوق 

اللوني او النسيج.
Ctrl + H القيام بفتح مربع حوار اللون الخافت.

Shift + Z القيام بتنشيط وضع الكائن النشط.
Ctrl + K . القيام بتمكين او تعطيل عمل القناع عن طريق وضع قناع مخطط فوق صورك الا في حالة 

وجود اختيار.
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Adjust menu     قائمة التعديل

Shift + C القيام بأدارة العملية آليا.
Ctrl + F9  القيام بفتح او اظهار صندوق حوار العملية الالية

Ctrl + B القيام بفتح مربع حوار اللمعان و التشبع
Ctrl + E القيام بفتح مربع حوار السطوع و الصبغة .

القيام بفتح صندوق حوار تعديل الطيف اللوني.   Ctrl + Shift + T
القيام بفتح تعديل مربع حوار الطيف و الظل.   Ctrl + Shift + H

Ctrl + L  القيام بفتح مربع حوار موازنة اللون
F9 القيام بفتح او تفعيل مفاعل تثبيت و اصلاح الصور المأخوذة بالسكانر.

F10 القيام بفتح او تفعيل مربع حوار الاصلاح او التثبيت السريع للصور.
Ctrl + G القيام بفتح مربع حوار التحجيم.
Shift + N القيام بفتح مربع حوار التحجيم

Photo menu       قائمة الصور

F10 القيام بفتح او تفعيل مربع حوار التثبيت السريع للصور
Shift + C القيام بعملية ادارة الصور

Ctrl + B القيام بفتح مربع حوار اللمعان و التشبع
القيام بفتح مربع حوار التنقية   Ctrl + Shift + F

Ctrl + L  القيام بفتح مربع حوار موازنة اللون
Ctrl + E القيام بفتح مربع حوار السطوع و الصبغة .

القيام بفتح صندوق حوار تعديل الطيف اللوني.   Ctrl + Shift + T
القيام بفتح تعديل مربع حوار الطيف و الظل.   Ctrl + Shift + H

Shift + F القيام بفتح مربع حوار تأطير الصورة

Effect menu قائمة المؤثرات                                               
 Shift + P

القيام بتطبيق المؤثر او تفعيله.

Selection menuقائمة الاختيارات                                              
تفعيل او عدم تفعيل اختيار الصورة   Space

Shift + G اخماد تفعيل مناطق العمل في الصورة
Ctrl + A القيام بأختيار المناطق او المحتويات الداخلية في الصورة.

القيام بتحويل ما تم اختياره الى كائن رسومي.   Ctrl + Shift + O

F5 القيام بحفظ الصورة الاصلية قبل اجراء التعديلات عليها.
Ctrl + Alt + E القيام بحفظ او طبع الاختيار الحالي الى مكتبة الصور في قاعدة بيانات البرنامج.

Object menu قائمة الكائنات الرسومية                                                                            

Shift + D القيام بمضاعفة الصورة او الكائن الذي تم اختياره.
Shift + M القيام بمزج الكائن الذي تم اختياره مع الصورة الاصلية.

القيام بمزج او توحيد كل الكائنات المشكلة الى صورة واحدة.   Ctrl + Shift + M
Del القيام بأزالة الكائنات الرسومية التي تم اختيارها.

القيام بأختيار جميع الكائنات الرسومية في صورة ما.   Ctrl + Shift + A
القيام بألغاء اختيار كل الكائنات الرسومية في صورة ما .   Enter

Shift + E القيام بتحرير النوع الذي يتم اختياره من الكائنات الرسومية.
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Shift + W القيام بأظهار مربع حوار خواص الطي و الالتفاف للكائن الذي يتم اختياره.
Shift + Q القيام بعملية التنعيم او الغاء الحواف.

Ctrl + Alt + G القيام بتوحيد الكائنات الرسومية التي تم اختيارها في كائن واحد.
Ctrl + Alt + U القيام بتفكيك الكائن الذي تم اختياره الى كائنات منفصلة.

Alt + Up القيام بأستدعاء الكائن الذي تم اختياره الى المقدمة.
Alt + Down القيام بأستدعاء الكائن الذي يتم اختياره الى المؤخرة.

Ctrl + Alt+Up القيام بتحريك الكائن الذي يتم اختياره الى مستوى اعلى .
Ctrl + Alt+Down القيام بتحريك الكائن الذي يتم اختياره الى مستوى ادنى 

Shift + S القيام بفتح مربع الحوار الخاص بنافذة الظل.
Ctrl + Shift + Enter القيام بفتح مربع حوار خواص الكائن عندما يكون الكائن مفعلا. 

Web menu قائمة الموقع الالكتروني                                                                                    

Shift + T القيام بفتح مربع حوار النص المضمن بلغة الهتمل. 
Shift + L القيام بربط الكائن من ملف الى الصورة الحالية.

Shift + R القيام بفتح مربع حوار المنسدلة .
F12 القيام بفتح مصمم مكونات الويب.

Shift + B القيام بفتح مربع حوار مصمم الخلفيات.
Shift + Enter القيام بفتح مربع حوار خواص الموقع الالكتروني.

F4 القيام بفتح مربع حوار معرف الصور.

View menuقائمة المشاهدة                                                                                             

القيام بتخليق نسخة اخرى من الصورة الموجودة.   Ctrl + I
Ctrl + 0 (number) القيام بأظهار الحجم الحقيقي للصورة 

Ctrl + M القيام بتكبير النافذة بنسبة 1:1
+ القيام بتكبير الصورة.

- القيام بتصغير الصورة.
القيام بتكبير الصورة الى الحجم المطلب بحيث تناسب النافذة.   Ctrl + Shift + 0

Ctrl + U القيام بأظهار / اخفاء كل اشرطة الادوات من اجل الحصول على مشهد كامل
Ctrl + F5 القيام بأظهار / اخفاء الصورة الاساسية و خلفية الموقع .

Shift + F12 القيام بأظهار الشريط النصي المتحرك.
Shift + V اظهار / اخفاء المسطرة.

Shift + F7 اظهار / اخفاء خطوط التقطيع.
Shift + F8 اظهار / اخفاء الصورة – الخريطة.

اظهار / اخفاء خطوط الدلالة.   Ctrl + Shift + G
اظهار خاصية الانجذاب لخطوط الدلالة.   Ctrl + Shift + L

اظهار / اخفاء الشبكة.   Ctrl + Shift + R
القيام بتفعيل الانجذاب الى الشبكة.    Ctrl + Shift + N

Workspace menuقائمة مساحة العمل                                                                              

F3 اظهار و اخفاء اداة ادارة الطبقات.
F7 اظهار و اخفاء اداة ادارة الوثائق.

F8 اظهار و اخفاء اداة ادارة المستعرض.
F2 اظهار و اخفاء اداة اللوحة السريعة.

Shift + F3 اظهار و اخفاء قائمة اللون.
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Ctrl + F2 اظهار و اخفاء قائمة الاوامر السريعة.
Ctrl + F3 اظهار و اخفاء اعدادات الادوات.

Window menuقائمة النافذة                                                                                            

Shift + F5 القيام بترتيب كل النوافذ المفتوحة في مساحة العمل من اليمين الى اليسار او من الاسفل 
الى الاعلى.

Shift + F4 القيام بتوزيع كل النوافذ المفتوحة عموديا في مساحة العمل.

Help menuنافذة المساعدة      
                                                                                         

F1 القيام بفتح نافذة اليوليد فوتوامباكت على الانترنيت.

تم بـعــونـه تــعــالــــى


